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Notification

Each time you want to copy material to  a CD, make sure you are allowed to make a copy. 

Many CD’s are protected by copyright laws. This usually means you cannot make a copy at all (as is the 
case with most audio CD’s, video CD’s and CD-I). If the CD contains software, you are allowed to make 
one backup copy for archival purposes only. 

If the CD contents are not protected by any copyright law, you are free to make as many copies as you 
want.  This manual refers to optional components such as DVD, Tape and Jukebox support.  Please contact 
your point of sale for additional information as to how to obtain these components if needed.

Disclaimer

GEAR Software provides this publication “as is,” without warranty of any kind, either express or implied, 
including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. 
GEAR Software may make improvements or changes in this publication, or in the product and programs 
described in this publication, at any time and without notice.

Copyright © 1991–2000 by GEAR Software, a Division of Command Software Systems. All other brand 
names are trademarks of their respective holders.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, 
without prior written permission from GEAR Software.

Printed in the United States for US distribution.
Printed in the Netherlands for EU distribution.
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Welcome to GEAR

What is GEAR?
GEAR has powerful and comprehensive software solutions for the production of 
DVDs and CDs. It is available in several editions:

GEAR LE for Windows is an Lite Edition of the advanced GEAR PRO CD-R 
software package that allows you to create data and audio CDs and use a 
single button CD copy command or Wizard. Its upgrade path include the 
following packages.

GEAR PRO is a well-established CD Pre-mastering and CD creation product. It 
offers you everything you may wish for in CD premastering software, but it 
does not support the new DVD technology. GEAR PRO is available for 
Windows 95/98 and NT 4.0/Win2000 as well as many Unix platforms. Its 
latest iterations include audio editors, MP3 support and a Wizard.

GEAR PRO DVD for Windows is an advanced DVD/CD software package that 
allows you to premaster DVDs and CDs for Digital Audio, Video, Game 
titles, multimedia productions and much more. Also you will be able to 
write and erase CD-ReWriteable discs. Its latest iterations include audio 
editors, MP3 support and a Wizard.
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Use GEAR to
With GEAR products you can:

• format data files into a DVD-ROM image that conforms to the UDF standard; 

• write a DVD/CD premaster tape in DLT format (the preferred format for DVD) or 
DDP format (for CD) on 8 mm Exabyte or 4mm DAT;

• erase a CD-RW to prepare it for re-use;

• format data into a CD-ROM image that conforms to the ISO 9660 or UDF 
standard;

• write a compact disc (visit our website at www.gearsoftware.com for a full list of 
supported recorders).The CD-R discs produced with GEAR are fully compatible 
with normally mastered CDs;

• use a jukebox to write several CDs unattended.

Features overview

GEAR PRO 
DVD for 

Win95/98/
NT 40/2000

GEAR PRO 
for

Win 95/98/
NT 4.0/2000

GEAR for
Unix

GEAR
Lite Edition

Write DVD x

Write tape x x

Erase CD-RW x x x x

Jukebox control x x

Write CD-R x x x x



Made by GEAR Software 13

W
elcom

e

1

Supported standards & formats

GEAR’s formatting engine supports the following standards: 

• UDF (Universal Disc Format)

• CD-ROM, ISO 9660

• CD-ROM Mixed Mode

• CD-ROM XA

• CD Plus (Blue Book)

• ISO 9660 with Rockridge extension (Unix version)

• Multi-session

• CD Digital Audio

In addition, GEAR supports recording of the following authored file formats:

• CD-I (Compact Disc Interactive)

• CDTV

• EB (XA)

• Photo CD

• Proprietary video game authoring (3DO, Nintendo, Sega, CD Karaoke, and other 
game titles)

• VideoCD

• Compressed and encrypted file formats

• Custom-generated images

If you would like to know more about DVD and CD technologies please refer to the next 
chapter. It will provide you with all the information you need. 

Made by GEAR Software
As a pioneer in the field of recordable disc technology, it has always been the goal of 
GEAR Software to make state-of-the-art CD-R technologies available to everyone in 
the form of advanced and user friendly desktop software. GEAR PRO DVD provides 
new proof that GEAR Software continues to set the standard in DVD/CD recordable 
software.
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Installing GEAR PRO

This chapter provides information about installing GEAR PRO under Windows 
95/98 or Windows NT/2000. In this chapter, you can read about the following:

• Product Registration

• System requirements

• Configuring your hardware

• Installing the software

Product Registration
Registering your software is an important part of software ownership, as your 
registration provides essential information to software manufacturers.  Most 
software developers, including GEAR Software, require that your software be 
registered in order to receive technical support.  In order to make sure you can fully 
enjoy your new purchase, take a brief moment to register your product with us.  

To register, simply email us at: register@gearsoftware.com

In your message, make sure you include 

• your GEAR Software product name, version number and serial number

• your current mailing address and phone number
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System Requirements
In this section, the system requirements are listed for the various versions of GEAR. 

Windows 95/98/NT/2000

To run GEAR PRO under Windows 9X/NT/2000, you need the following 
configuration:

• A Pentium 166 or faster CPU

• Windows 95/98 or Windows NT/2000

• A supported CD-R or CD-RW

• A minimum of 25 Mb free disk space for project management

• Enough space for the virtual or physical image to be written

• A fast HDD (12 ms average access or less)

Configuring Your Hardware (SCSI only)
This section includes information for configuring the necessary hardware for 
connecting a CD recorder. Separate sections are included for Windows 95/98 and 
Windows NT/2000.

Keep the following in mind when you start configuring you hardware:

• We recommend you connect the SCSI recorder close to the SCSI Controller. The 
SCSI cable should be no longer than 1 meter (or 3 feet), but the shorter the cable, 
the better.

• Be sure to terminate both ends of the SCSI chain properly! All units are susceptible 
to signal degradation, which can cause a loss in data integrity or unexpected error 
messages.

• It is not necessary to connect the recorder on the fastest controller. In some cases, 
the faster controllers cause miscompares with the recordable and your original 
files, making the CD-R unusable. 

Important: Always read the manufacturer’s instructions before installing hardware. Prob-
lems you may encounter during the installation of GEAR are usually due to hardware-related 
installation problems.
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Windows 95/98

Since Windows 95/98 is supplied with an integrated SCSI I/O driver, no additional 
third party adapter driver is required in most cases. This version of GEAR supports 
the Gearaspi or WinASPI32 device driver for Adaptec cards and has been 
successfully tested with the Adaptec, Advansys, Buslogic, Initio, and Diamond 
adapters. Visit our website at www.gearsoftware.com for an up-to-date list of 
supported adapters.

Note: You can verify the proper installation of your SCSI adapter by choosing Settings from 
the Control Panel. Double-click the System icon. Select the Device Manager. If a host adapter 
is installed, the SCSI Controllers item should be included in the list of available drivers. Click 
this item to display the supported host adapter. Select the device and click the Properties 
button to view the current status of the host adapter.

Connecting Your Recorder

Installing a Non- Plug & Play-Compatible Recorder (Device Type 4, WORM)

Due to incompatibilities with Device Type 4 CD recorders and Windows 95/98 SCSI 
drivers, type 4 recorders currently cannot be mounted as CD readers. However, 
Windows 95/98 will automatically want to associate a driver with the recorder. When 
you are asked which driver to use, you must choose the CD-R to be an ‘Unsupported’ 
device. 

Installing a Plug & Play-Compatible Recorder (Device Type 5, CD-ROM)

If your recorder is a device type 5 recorder, Windows 95/98 installs a CD-ROM. For a 
full list of device type 5 recorders, visit our website at www.gearsoftware.com .

To connect your CD recorder:

1. Shut down your system and connect your recorder to your SCSI host adapter.

2. Restart Windows 95/98 with your recorder turned on.

• If your recorder is a device type 4 recorder, Windows 95/98 prompts you to 
install a device driver. Since Windows 95/98 does not provide drivers to 
mount type 4 recorders as readers, choose Unsupported in the window that 
appears. (See Installing a Non-Plug & Play-Compatible Recorder, above.)

• If your recorder is a device type 5 recorder, Windows 95/98 installs it auto-
matically and does not prompt you.

Note: The installation program will install a Gearcdr.vxd (device driver) that will disable the 
Auto Insert Notification of your CD Recorder while GEAR is running.
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Note: Follow the manufacturer’s instructions when you set up the SCSI host adapter and your 
CD recorder. Be sure to terminate both ends of the SCSI chain properly! All units are susceptible 
to signal degradation, which can cause a loss in data integrity or the reporting of strange errors.

To verify whether the installation was successful, reboot your machine and check the 
system properties. If Windows does not find the CD recorder, run a system scan by 
choosing Add Hardware in the Control Panel. Be sure WinASPI32 is installed properly. 
If the recorder is still not recognized, contact GEAR Software Technical Support.

Windows NT/2000

Since Windows NT is supplied with an integrated SCSI IO driver, no additional third 
party adapter driver will be required (You may however use the included drivers for 
better performance). We successfully tested GEAR with the Adaptec, Buslogic, and 
Advansys adapters.

For information about setting up your hardware, see your hardware documentation.

Connecting Your Recorder

Installing a Non- Plug & Play-Compatible Recorder (Device Type 4, WORM)

Due to incompatibilities with device type 4 CD recorders and Windows NT SCSI 
drivers, type 4 recorders currently cannot be mounted as CD readers. 

Installing a Plug & Play-Compatible Recorder (Device Type 5, CD-ROM)

If your recorder is a device type 5 recorder, Windows NT installs a CD-ROM driver 
automatically since Windows NT recognizes device type 5 recorders as CD-ROM .

Note: An alternative would be to install WINASPI or GEARASPI. 

Note: Follow the manufacturer’s instructions when you set up the SCSI host adapter and your 
CD recorder. Be sure to terminate both ends of the SCSI chain properly! All units are susceptible 
to signal degradation, which can cause a loss in data integrity or the reporting of strange errors.
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Installing GEAR PRO

Windows 95/98/NT/2000

1. Insert your GEAR CD into your CD reader. On Windows 95/98/NT/2000 
systems with the Auto Insert Notification enabled, the installation program 
will start automatically. In all other cases:

2. Run Setup.exe. This program will guide you through the installation process.

Important: We strongly advise you not to install GEAR on a server.

We recommend you read the ReadMe files of each program you installed. They 
include important last minute information. You will find the readme.txt file for 
GEAR in the root directory of the GEAR CD. 

Supported recorders
Gear supports most of the CD and DVD-R recorders in the market. Visit our website 
at www.gearsoftware.com for updated lists of recorders and drivers. You will also find 
answers to frequently asked questions.
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Getting Help

This chapter provides information about the user documentation and other forms 
of support available to you. In this chapter, you can read about the following:

• The manual

• On-line help

• Technical support

• Addresses

The Manual
This manual is separated into multiple sections: 

• A general section containing an explanation of the concepts involved in 
recordable disc technology and the installation instructions.

• Sections with specific information about the product.

• Appendices with additional information

Conventions

Special information is denoted as a Note, Important or Warning!.

Buttons you should click on the toolbar to perform a function appear in the margin 
next to their corresponding text.

New terms you may not be familiar with appear in italics.
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On-line User Manual (Acrobat Reader)

In addition to the printed documentation we have included the complete user 
manual on the installation CD. 

The documentation has been formatted under the Adobe Acrobat Portable 
Document Format (PDF), and includes a copy of Adobe Acrobat Reader to search, 
view, retrieve, and print the on-line user manual. Visit the website at 
www.adobe.com for more information on the Acrobat Reader.

Note: The installation program will offer you the option to install the Acrobat Reader.

Using the On-line Help 

On-line help is available at any point in time to help you creating your CDs. 

Windows 95/98/NT/2000
To access help, do any of the following:

• Press F1 or choose Index from the Help menu to display the help Index.

• Choose Using Help from the Help menu for standard Windows information 
about using an on-line help system.

• Choose About GEAR from the Help menu to display version and registration 
information about your copy of GEAR.

Technical Support

For frequently asked questions on GEAR and other GEAR Software products, visit 
our website at www.gearsoftware.com .

For support contact GEAR Software at:

GEAR Software Europe GEAR Software USA

E-mail: 
support.eu@gearsoftware.com

E-mail: 
support.us@gearsoftware.com

http://www.gearsoftware.com http://www.gearsoftware.com
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You can also contact GEAR Software at one of the addresses listed below.

GEAR Software addresses

GEAR Software Europe GEAR Software USA

Millbank tower
Millbank, London SW1P 4QP

The United Kingdom

1061 E. Indiantown Road
Suite 500

Jupiter, Florida 33477
United States of America

Phone: +44 207 931 9301
Phone: +31 492 59 4094 (sales)

Phone: +1 561 575-4327 (sales)

Phone: +44 207 931 9301
(technical support)

Phone: +1 561 575-4327 (east coast)
Phone: +1 408 364 2237 (west coast)

(technical support)

Fax: +44 207 931 9302
Fax: +31 492 47 6110
(sales, tech support)

Fax: +1 561 575-3026
(sales, east coast tech support)

Fax: +1 408 364 1074
(west coast tech support)

E-mail: 
sales.eu@gearsoftware.com

E-mail: 
sales.us@gearsoftware.com

http://www.gearsoftware.com http://www.gearsoftware.com
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What you should know 
about DVDs & CDs

This chapter introduces and explains some important concepts that will help you 
understand DVD and CD recordable technology and its applications. In this 
chapter you can read about:

• DVD and CD: the basics

• DVD: concepts & standards

• CD-ReWritable

• Virtual image vs. Physical image

• Writing a disc

• Recording methods

If you are already familiar with the concepts of DVD/CD recording, skip to 
Installing GEAR PRO on page 15 to get started.
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DVD and CD: the basics

A mass-produced DVD/CD (recognizable by its silver color), for example an Audio CD 
or a CD-ROM, is a non-magnetic, polished metal disc which is used to store digital 
information. Tiny indentations have been pressed in this disc, which are called pits. In 
a DVD/CD drive this disc is scanned by means of a laser beam. Because the pits reflect 
the light from the laser differently than the rest of the surface, the drive can interpret 
surface and pits as binary information; ones and zeros. The information on such a disc 
can only be read; no data can be added (or deleted) afterwards. 

What makes a recordable disc, such as a CD-R or DVD-R (which is currently being 
developed), different from an ordinary DVD/CD is a layer of organic dye that has been 
added to a perfectly smooth reflective surface. In the DVD/CD recorder a laser beam is 
used to burn a pattern in the organic dye. When you place the disc in the DVD/CD-
drive, these burns cause changes in the reflection of the laser light in much the same way 
as do the pits on a manufactured disc. Any DVD/CD-drive can therefore read the 
information you write on a recordable disc. Once written, these burns cannot be deleted. 
Each part of the disc can therefore be used only once. You can, for instance, use 
recordable discs to create premaster discs that can be used to mass-produce DVDs/CDs 
in a mastering and replication plant.

The information on a Rewritable disc (CD-RW or DVD-RAM) can be erased to make 
place for new data. The surface of such a disc can be smoothed by means of a separate, 
high intensity laser beam in the recorder, preparing the disc for reuse. In this way a CD-
RW or DVD-RAM can be used many times.

DVD: concepts and standards

The ever increasing need to store very large amounts of data on a portable medium has 
led to the development of the Digital Versatile Disc (DVD). A DVD, although the same 
size as a CD, can hold 4.7 - 17 GB of data, compared to the 650 Mb that a CD can hold. 
For this reason it is now widely regarded as the successor of the CD. 

DVD disc capacity

The increase in storage capacity of DVD has first of all been made possible by 
enhancing the density of the disc, which brought the capacity to 4.7 GB. However, 
DVDs will soon become available in double sided and dual layer versions. The effects 
of these innovations on DVD disc capacity are shown in the table below:
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Note: At present, GEAR PRO DVD supports the creation of premaster tapes for 3,95 Gb 
and 4,7 Gb DVDs. The next version of GEAR PRO DVD will support larger DVD formats. 

Applications

DVD is the right format for applications in the fields of:

Video DVD-VIDEO disc can hold a movie (and its sound track) of 
approximately 133 minutes, providing a resolution that surpasses 
current S-VHS standards. 

Audio DVD-AUDIO will put an end to the limitations of music CDs and 
provide the listener with playback sound of a quality that closely 
approaches that of a live performance.

Multi-media DVD-ROM will greatly facilitate the use of real video, high 
resolution graphics and truly interactive scripts in multi-media 
productions, effectively eliminating any restrictions to the size of 
such applications.

DVD-R and DVD-RAM

The next step in DVD-technology is DVD-Recordable (DVD-R) and DVD-Rewritable 
(DVD-RAM). 

DVD-R is fully compatible with DVD-VIDEO and DVD-ROM formats, including a 
disc capacity of 4.7 GB. This makes DVD-R the best choice for archiving purposes 
(including DIS applications) and the creation of multi-media productions. DVD-RAM 
discs offer computer users 2.6 GB of re-usable storage space on each side (5.2 GB for 
double sided discs), providing them with maximum storage flexibility. 
Needless to say, both DVD-R and DVD-RAM will be fully compatible with 
DVD-VIDEO an DVD-ROM formats.

UDF & ISO 13346
The way files are organized on a DVD/CD is determined by the file system, which 
defines, for example, the number of levels in a directory tree or the length and format of 

Single Sided Double Sided

Single Layer 4.7 GB 9.4 GB

Dual Layer 8.5 GB 17 GB
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the file names. A standard file system ensures the exchange of data between different 
platforms. 

The file system used to store data on CD (ISO 9660) proved to be inadequate to make 
full use of the storage potential of DVDs. To remedy this, the new ISO 13346 standard 
for optical media was developed. 
The Optical Storage Technology Association (OSTA) has further refined ISO 13346 in 
order to maximize data interchange, creating a flexible format that is eminently suited 
for incremental writing (see page 33). The resulting format is called Universal Disc 
Format (UDF). Although it is not an official standard, UDF has since become a de-facto 
standard for the industry. (For more information on OSTA and its work you can visit the 
organization’s website at www.osta.org.)

Besides creating DVDs in ISO/UDF, GEAR DVD allows you to create hybrid 
ISO 9660 / UDF CDs being backward compatible with ISO 9660.

Note: Although UDF is more focused on incremental writing, it can also be used with Track at 
Once and Disc at Once.

CD Rewritable

GEAR supports writing to CD-ReWritable discs. CD-Rewritable (CD-RW) is a new 
CD technology enabling you to erase recorded information and write new data in its 
place. You can use a CD-RW recorder to write both CD-RW discs and CD-R discs. Only 
CD-RW discs can be erased, however. 

With GEAR you can erase the whole CD-RW, a feature every CD-RW drive supports. 
Erasing the last track or overwriting a specific packet of an incrementally written disc 
will be supported by GEAR as soon as these features are implemented in CD-RW 
recorders. 

To read a CD-RW disc you need a CD-RW recorder or a multi-read drive, which can 
read CD-ROM, CD-R and CD-RW discs. The multi-read specifications which will set 
the standard for the multi-read drives were close to completion at the time of printing.

Virtual Image vs. Physical Image

Before you can write data to DVD/CD-R you must first collect and order the data that 
need to be recorded. There are several ways to go about this.
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Virtual Image

Whenever you create a project in GEAR, a virtual image is created. This is an 
administration file which contains all the necessary information about the files you 
want to store on disc. This includes the directory structure to be used on the disc and 
the location of the files on your hard disk. When you start copying your data onto the 
DVD/CD-R, the virtual image controls the actual recording process by loading the 
files from your hard disk in the correct order and by writing each file to the right 
place on the compact disc.

Physical image

Sometimes you may want to use a physical image, a bit-to-bit copy of the disc you 
are about to write. You should use this method when the transfer rate for recording 
has to be increased (for example when recording a large number of small files). The 
obvious disadvantage is that you need a lot of free disk space. 

External/foreign image

GEAR also enables you to write external or foreign images to DVD/CD. This is an 
image produced by a software tool other than GEAR. For some CD formats, GEAR has 
to make use of foreign images. It is not possible within GEAR to create an image for the 
following types of CDs: CD-I, CDTV, HFS and 3DO. These types can only be 
processed by means of an external/foreign image.

Writing a disc
Two concepts are important in understanding how to write a disc with GEAR: tracks 
and sessions. Both concepts will be explained below:

Tracks 

Data is written to DVD/CD in tracks. Each track contains a separate set of data. For 
example, a track on a DVD-ROM or CD-ROM usually consists of different files. An 
Audio track, on the other hand, always contains one single audio file. The maximum 
number of tracks a CD-R can contain is 99, regardless of the number of sessions or the 
type of tracks on the disc.
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Track types in GEAR
For the various CD-formats that GEAR supports, a few basic track types are used:

UDF/ISO the appropriate format for DVDs. GEAR does support writing to 
CD-R in ISO/UDF format, but this is mainly for reasons of future 
compatibility.

ISO a track type pre-eminently suited for recording computer data 
(CD-ROM). This format always consists of 1 track. 

XA a track type used for CD-ROM XA, EB, Photo CD, Video CD and 
multi-media applications. It always consists of 1 track.

DA a track type for digital audio. This format allows for 1 - 99 tracks. If 
audio tracks are combined on a disc with an ISO or XA track, a 
maximum of 98 audio tracks can be used (see below, Combining 
Track Types). 

Combining track types
When you combine different track types in one session, you are creating a Mixed Mode 
disc. The following track combinations are possible:

• 1 ISO track and up to 98 Audio tracks

• 1 XA track and up to 98 Audio tracks

• 1 - 99 Audio tracks

Combinations 1 and 2 can be repeated for each session on a Multi Volume or Multi 
Session disc, although the maximum number of tracks for the whole disc is always 99. 

Note: When recording multiple audio tracks only, you should not create a multi-session disc.

If you add an audio track to a multi-session disc, only a multi-session player can play 
this audio track. Most audio CD players cannot handle multi-session audio discs. To get 
round this problem you can use a structure called CD Extended or CD Plus. The first 
session of such CD-Rs have multiple audio tracks and the subsequent sessions are used 
for data. An audio player only recognizes the first session (i.e. the audio tracks) whereas 
a multi-session CD-ROM player recognizes both audio tracks and data tracks.

Writing a disc in one or more sessions

A session is a recorded segment of a compact disc that contains one or more tracks (data 
or audio) preceded by a lead-in and closed by a lead-out. When you record a session, the 
lead-in and lead-out contain information about the recorded data, such as a table of 
contents.
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You can record a disc either in one or in several sessions. The method you decide 
to use depends on the capacity required and the function of the recording. Single 
Session recording uses the available CD-R space much more efficiently. Multi 
Session, on the other hand, is much more flexible and enables you to use your disc 
more than once:

Single Session
Single-session refers to discs that contain data written during one session. When all 
the tracks are written, the disc is fixated by writing the lead-in and lead-out. Once 
you fixate a single-session disc, you can add no more data to the disc. The following 
illustrates a single session CD.

Multi-Session 

If you want to write only limited amounts of data at a time you need to create a multi-
session disc. The data recorded in each session is linked, allowing a newer session to 
refer to data in an older session. When you want to append a session to a multi-session 
disc, GEAR reads back the last session on the disc and creates a virtual image of it. This 
image can then be used like any other image to add, delete and update data. If you delete 
information from a session, the old data is not actually deleted, but only the reference to 
the data. This means the old file can no longer be read. When you write the new session 
to the disc, only the changes are written.

The structure of a multi-session disc may look like this: 

A true multi-session CD-ROM drive will automatically skip to the most recent session 
and present all linked sessions as one. As a user you will never be aware of the number 
of sessions on the disc. This makes Multi Session especially suitable for document 
archiving or regular updates of catalogs. A drawback of this method is the large data 
overhead required for each session: 15 Mb.
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Multi-Volume 
Multi-volume writing is a variation on multi-session writing. When you write a multi-
volume disc, each session or project on the disc is independent and has no reference to 
other projects on the disc. You can read each project as a separate CD. In order to read 
a multi-volume disc, you need a device driver that allows you to select a project on the 
CD-R as a separate drive letter or partition. 

GEAR fully supports the creation of multi-volume discs. If you want to add a volume 
to a disc, you can create the volume as you do any other project. When the project is 
ready, you put the CD-R disc you want to add the volume to in the recorder and start 
writing. 

Recording methods
When a recorder is writing data to a disc, it cannot wait for the data like a tape unit can, 
for example. The data buffer of the recorder must always contain data.

You can stop the transfer of data to the recorder at specific points only. These points are 
determined by the method used to write the disc—disc at once, track at once, or in 
incremental write. At these points—end of disc, end of track, or end of packet—the 
recorder finalizes the writing of data and you can resume writing at a later time.

Warning! If the recorder cannot finalize the disc because it runs out of data unexpectedly, the 
DVD/CD-R disc is wasted and cannot be reused. This is referred to as a buffer underrun. There-
fore the data transfer rate to a DVD/CD recorder is very important.

Track at Once and Disc at once

Nearly all CD recorders on the market support Disc at Once and Track at Once writing 
of CDs. When you use a track-at-once recorder, the recorder first writes the track data 
and then finalizes the disc by writing a lead in and lead out. Track at once is particularly 
useful for multi-session writing. Only track-at-once recorders can write multi-session 
discs.

When you use a disc-at-once recorder, the recorder starts by writing the lead in, then the 
track data, then the lead out. Link blocks are not inserted. Disc at once is useful for 
audio-only discs and discs that should be an exact copy of the original.
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Incremental Write

This recording method allows you to divide a data track into small amounts of data 
called packets (typically 64 Kb - 1Mb) and write each data packet separately to 
DVD/CD-R disc. Each packet will use some extra disc space for data overhead. The 
amount of overhead depends on the size of the packet an is on average about 15%.

The following illustration shows the difference between writing Track at Once and 
incrementally:

In between the writing of packets, there are virtually no data rate constraints. This 
means that writing can be interrupted for an unlimited amount of time, which reduces 
the risk of buffer underruns when writing large amounts of data to CD. 

Incremental write can be used in different ways:

• on the logical level, fixed packet writing can either be combined with UDF, which 
is eminently suited for incremental writing or it can be combined with another file 
system such as ISO 9660, or a combination of both. 

• on the physical level, the Orange Book standard (see page 106) offers you the 
option use a fixed packet size or a variable packet size. The advantage of fixed 
packets is that they eliminate the risk of buffer underruns. Variable packet size, 
which differs with the size of the files to be written, offers more backward 
compatibility.
GEAR uses fixed packet writing as the formatting process for this method is the 
same as with the other writing methods. Fixed packet writing can also be used in 
combination with multi-session writing. 

Note: A special driver is required to read incrementally-written discs. Currently, most CD-
ROM readers on the market cannot read an incrementally-written disc. This means that in all 
probability a disc written in fixed packets can only be read with the recorder type that was used 
to write it. 

lead in L data L lead out

Track at once 

lead in L packet L packet L packet L lead out

Incremental write
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More about . . .

In this chapter you will find more information about the various DVD and CD 
formats.

• Selecting the appropriate DVD/CD type for your project

• Project data capacity

• Hybrid ISO/UDF projects (DVD)

• CD-ROM projects

• CD-ROM XA projects

• Audio projects

• External Images

• Multi-Session Discs

• Track lists

Selecting the appropriate DVD/CD type for your project
GEAR supports the writing of many different DVD/CD types. On top of that there 
are several recording methods to choose from. The table below shows the preferred 
setting for the most common applications. It may serve as a quick reference to help 
you choose the right DVD/CD type and recording method for your project.
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*GEAR DVD only

**GEAR for Mac OS only

Type of project
DVD/CD type
(Windows 95)

CD Type
(Mac OS)

Settings

DVD* ISO/UDF n.a. Verify after write advised

Archiving & 
backup of data

CD-ROM ISO Multi Session preferred

Audio only CD Audio DA Disc at Once preferred

Audio collection CD Audio or
CD Track List

DA or
Track List

Disc at Once preferred

Multi Media CD-ROM XA XA

Combining ISO 
and Audio tracks

Mixed mode 1 Mixed mode ISO or
Mixed mode XA

Combining ISO/
XA and Audio

Mixed mode 1 (ISO)
or 2 (XA)

Mixed mode ISO or
Mixed mode XA

Photo CD External image Photo CD predefined format=
XA mode 2 (type 4)

CD-I External image CD-I predefined format=
CDI mode 2 (type 10/7)

Video CD External image Video CD : predefined format=
XA mode 2 (type 4)

External Image Ext. image (1 file) or
CD Track list

(>1 file)

Custom Format
(1 file) or

Track List (>1 file)

Track list requires
Disc at Once

Replicating a CD depends on track
type(s) of original

depends on track
type(s) of original

Disc at once preferred

Multi-platform 
CD**

n.a Hybrid (ISO+HFS)
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Project Data Capacity
The following table shows the data capacity for each disc size and track type:

If necessary, you can use the following formula to calculate the data capacity:

data capacity = sector data capacity (bytes) x length (minutes) x 60 (seconds) x 75 (number of sectors)

The following table shows the sector data capacity for each track type:

Hybrid ISO/UDF projects (GEAR PRO DVD only)
For step by step 
instructions, see page 51.

A Hybrid ISO/UDF project is mainly used for creating large images for DVD premaster 
tapes. It always consists of one ISO/UDF track. The Hybrid ISO/UDF project is created 
to ISO/UDF standards with error-checking capabilities (EDC/ECC codes). This is 
referred to as Hybrid MODE 1 format.

Note: It is possible to write a CD-R in ISO/UDF format. However, this option is only useful for 
future compatibility with DVD drives. CDs in this format cannot be read on a CD-reader. 

Data Capacity & Disc Size

Type ISO and 
ISO/UDF

XA and CD-I CD Audio

CD-R(W) 18 min. 158 Mb 180 Mb 181 Mb

CD-R(W) 63 min. 553 Mb 631 Mb 653 Mb

CD-R(W) 74 min. 650 Mb 741 Mb 746 Mb

CD-R(W) 80 min. 703 Mb 802 Mb 807 Mb

DVD-R 428 min. 3.95 GB

DVD-R 509 min. 4.7 GB

Track Type Sector Data Capacity

ISO 2048 bytes

XA and CD-I 2336 bytes

CD Audio (DA) 2352 bytes
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The temporary output files of a ISO/UDF track with the extension .udf and .lvid are 
written to the GEAR working directory. Do not delete or edit these files manually; this 
results in a corrupt and useless project.

Note: * The 428 and 509 minutes image sizes are only available for ISO/UDF. These disc sizes 
are used for DVD premaster tapes. Future versions of GEAR will support the writing of DVD-R 
as soon as DVD recorders and discs become available. 

CD-ROM projects
For step by step 
instructions, see page 55 
(windows 95) 

The CD-ROM type is used for recording computer data and always consists of one ISO 
track. A GEAR CD-ROM project is created to ISO standards with error-checking 
capabilities. This is referred to as MODE 1 format (yellow book).

When you create a new project, several volume administration files are created in your 
current working directory/folder. Do not delete or edit the files in this directory/folder 
manually; this might result in a corrupt and useless project.

Note: When writing computer data to CD you are advised always to enable Verify after Write 
to make sure the files can be read.

Disc sizes ISO/UDF

CD-R 18 minutes 158 Mb

CD-R 63 minutes 553 Mb

CD-R 74 minutes 650 Mb

CD-R 80 minutes 703 Mb

DVD-Tape* 428 minutes 3.95 GB

DVD-Tape* 509 minutes 4.7 GB
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Copying a CD-ROM

For step by step instructions 
on how to copy a CD, see 
page 58.

There are two ways to make an exact copy of an existing CD-ROM:

From CD reader to CD recorder
This method can only be used if you have a CD-ROM drive which is fast 
enough (6x speed or faster). The advantage of this option is that you do not 
need much free space on your hard disk. If a buffer underrun occurs during 
writing, you can try lowering the recorder speed. If that does not help you must 
first copy the CD to your hard disk.

Using a hard disk copy of your CD
Copying your CD to hard disk is only possible if you have enough free space on 
your hard disk. The advantage of this option you do not need a separate CD-
ROM player. Also, if your CD-ROM player is rather slow you can still use the 
full speed of your CD-recorder. 

Using the Copy CD button
This will copy from a disc in CD-ROM or your CD-R(W) recorder to a new disc 
in your CD-R(W) recorder, using your hard disk for intermediate storage. In 
most cases this will result in an exact copy of your CD. 

CD-ROM XA projects
For step by step 
instructions, see page 55.

XA (eXtended Architecture) is a format that allows you to interleave two or more 
different file types, such as audio and video. Interleaving is necessary if the recorded 
tracks need to be synchronized during playback, as is the case in multi-media 
applications. 

Disc sizes CD-ROM 

CD-R 18 minutes 158 Mb

CD-R 63 minutes 533 Mb

CD-R 74 minutes 650 Mb

CD-R 80 minutes 703 Mb
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For example, with a mixed mode disc, the laser-reading head has to jump back and forth 
between widely separated tracks to play back audio and video data. This slows down the 
application significantly. When you use interleaving, the laser-reading head can pick up 
video, then move smoothly to the next amount of audio and so on, providing real-time 
playback. 

Choose XA to write the following formats: CD-ROM XA, EB, MMCD, Photo CD, and 
VideoCD.

Note: Playing XA interleaved files requires an XA decoder card.

Pre-interleaved files

GEAR assumes that the selected files are pre-interleaved:

• if you are running GEAR under Windows 95/98 you have to set interleaving to 
“pre-interleaved”. 

Important: Make sure the files you are loading are pre-interleaved files. Non-pre-inter-
leaved files you load this way are useless on the resulting CD-R disc. A pre-interleaved file must 
have a 2336 byte sector size with a subheader field filled in. This subheader field is copied, to-
gether with other information, to the GEAR administration file. Normally the subheader is not 
included in a file and the subheader information is generated by GEAR.

Audio projects

To create an Audio project, you need hard disk files that represent audio. GEAR 
supports the following formats:

• Red Book audio

• .wav

• AIFF

• Sound Designer II

Disc sizes CD-ROM XA 

CD-R 18 minutes 180 Mb

CD-R 63 minutes 631 Mb

CD-R 74 minutes 741Mb

CD-R 80 minutes 802 Mb
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Depending on the audio package you are using, the audio file may or may not 
contain a sound header. However, audio files should not contain sound headers 
when written to CD. If sound headers are not removed or cleared, they will cause a 
sharp click in the resulting audio track on the CD. For .wav, AIFF, and Sound 
Designer II files, GEAR removes the header automatically. 

Audio file requirements
The files must always fulfill the following requirements, which are specified in the 
Red Book:

• The sample frequency must be 44.1kHz.

• Audio must be stereo (one sample for the left channel and one sample for the right 
channel) sampled on 44.1kHz.

• Each sample must contain 16 bits.

• The byte order must be the same as the byte order used by your computer; if it is 
not, you can use the generic option MSBAudio (in gear.ini) to make GEAR swap 
the audio bytes for all tracks.

For example, LSB audio is the default for DOS and Windows. If you want GEAR to 
swap byte order, set MSBAudio=True in the gear.ini file.

You can load up to 99 audio tracks in your project. If audio tracks are combined on a disc 
with an ISO or XA track, you can create up to 98 tracks. The CD audio type is suited for 
CD Digital Audio.

Disc sizes Audio

CD-R 18 minutes 181 Mb

CD-R 63 minutes 653 Mb

CD-R 74 minutes 746 Mb

CD-R 80 minutes 807 Mb
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External/foreign Images
For step by step 
instructions, see page 64

An external/foreign image refers to any image you have created using another 
authoring or formatting package, such as CD-I, 3DO, or VideoCD. You cannot edit an 
external image in GEAR. However, you can use GEAR to write an external image to a 
CD-R disc or a premaster tape. Before you write an external image, you must select it 
and define its parameters.

The following project types are always processed as external images:

CD-I Most CD-I authoring tools generate a complete CD-I image, 
including EDC/ECC pregap and scrambling (GEAR type 10). This 
is done because these tools need to emulate the CD-I image. The 
second best optimal format is CD-I mode 2 with sector size 2336 
(GEAR type 7).

Photo CD Photo CD images are always in XA format—CD-ROM XA mode 2 
size 2336 (GEAR type 4) for external photo CD images.

Video CD Video CD images are always in XA format—CD-ROM XA mode 2 
size 2336 (GEAR type 4). 

When working with external images you must indicate which type of image will be 
used. You can choose any of the following predefined formats

Type # Image Type Format External Volume Type

1 CD-ROM Mode 1 (ISO etc.), sector
size 2048

Standard ISO, HFS, or CDTV image

2 CD-ROM Mode 1 (ISO etc.), sector
size 2352

Standard ISO with EDC/ECC codes

3 CD-ROM Mode 1 (ISO etc.), sector
size 2352, scrambled sectors with 2

seconds pre-gap

ISO with EDC/ECC codes, pre-gap, and
scrambled

4 CD-ROM XA Mode 2, sector size
2336

Standard XA or EB XA

5 CD-ROM XA Mode 2, sector size
2352

Standard XA with EDC/ECC codes

6 CD-ROM XA Mode 2, sector size
2352, scrambled sectors with 2

seconds pre-gap

XA with EDC/ECC codes, pre-gap, and
scrambled

7 CD-I Mode 2, sector size 2336 Standard CD-I without EDC/ECC codes

8 CD-I Mode 2, sector size 2352 Standard CD-I with EDC/ECC codes
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Things to Remember

Keep in mind the following about image types:

• The size of the pre-gap should always be two seconds (150 sectors).

• Scrambled images must contain sync, header, and EDC/ECC code information.

• Unscrambled images can be accepted with a 2,352 sector size without the sync, 
header, and EDC/ECC filled in.

• The byte order of audio files must be the same byte order used by the computer 
running the GEAR software. If this is not the case, you can use the generic option 
MSBAudio= in the Gear Preferences file to make GEAR swap the audio bytes for 
all tracks.

With LSB audio default, if MSBAudio=TRUE, each track will be swapped by 
GEAR. 
Audio files should not contain any sound header. If sound headers are not removed 
or cleared, they will cause a sharp click in the resulting audio track on the CD.
Audio files should contain only 16-bit samples and must be stereo (one sample for 
the left channel and one sample for the right channel) sampled on 44.1kHz.

• The external image files option lets you select one file only. If the external/foreign 
image consists of more than one file, use track list files (see below).

Track Lists
If you have a Disc at Once compatible recorder you can create a CD using a CD Track 
List. The CD Track List should contain all the tracks you want to record. You create the 
CD Track List in:

• the GEAR CD Track List editor (GEAR DVD only)

9 CD-I Mode 2, sector size 2352 with 2
seconds pre-gap

Standard CD-I with pre-gap, and EDC/
ECC

10 CD-I Mode 2, sector size 2352,
scramble sectors with 2 seconds pre-

gap

CD-I with EDC/ECC codes, pre-gap
and scrambled; uses the same output

format as that of most CD-I authoring
tools

11 Standard CD digital audio Red Book audio (44.1kHz, 16 bit,
stereo)

Type # Image Type Format (Continued) External Volume Type
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• any plain ASCII editor.

The track list file contains one or more lines where each line specifies a track of the CD-
ROM (you can use a full path). Each line should contain a file specification and a track 
type specification. You can also specify the length of the pause between two tracks. 
(Detailed information on Track List Files can be found in the GEAR Commands 
appendix on page 125).

Note: Place the track list and track contents in the same folder. 

Windows track list
For example, to write a mixed-mode image—one that contains mode 1 or mode 2 
data—you can specify the following lines in a track list file

Note: Be sure to leave a space between the track name and image type.

Note: Be sure to place a caret (^) with no space between the track name and image type.

Multi-Session Discs
For step by step 
instructions, see page 62.

By appending a multi-session disc, you can do the following:

• Add data to the disc

• Recover data from older sessions

• Skip the last session if there are read errors

• Create CD Enhanced or CD Plus discs

One of the sessions on the previously-recorded disc is used as the basis for a new image. 
The contents of the image is edited and finally, the image is written to the CD-R disc. 
The virtual image contains the same folder/file structure as the session and is displayed 
in the image window.

Append preferences

Before you start, you should select the append mode in the GEAR preferences. You can 
choose from the following modes:

track name path image type number

VIDEOTRACK1 /1
AUDIO1 /11
AUDIO2 /11
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Automatic Append GEAR uses the settings of the CD project you want to 
append to.

Manual Append You may select the track you want to append to and the 
type of track you want to append. Incorrect combinations 
of track types may result in a non-standard CD that cannot 
be read.

New append This mode will append an empty track. All previous 
sessions will become inaccessible. A disc lost due to a 
write failure can be used again after the writing of a new 
empty track.

Multi volume Append In this mode you will be able to create a multi volume disc. 
To enable the reading of the separate volumes, you will 
need special drivers for the CD player.

Readability and multi-session support

Some CD-ROM or CD-Recorder drives or drivers do not support multi-session. If so, 
the disc is not accepted, or only the data of the first session is visible.

To check if the CD is correctly recorded, you can try to append a new track. If the data 
in the Data Editor is correct, either your CD-ROM driver software or your CD-ROM 
player does not support multi-session. Contact your dealer or search the Internet for a 
CD-ROM driver update.
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Getting Started with GEAR PRO 

(Windows 9X/NT/2000)

This chapter helps you to get started with GEAR and provides concise step-by-
step instructions for working with various types of projects in GEAR.

In this chapter you can read about:

• Starting GEAR

• Create your CD

• The GEAR toolbar

• How to create a specific type of CD

Starting GEAR
Before you start GEAR, make sure your recorder is turned on and recognized 
when you boot your system. The setup program of GEAR has added the GEAR 
folder to the Programs item in the Start menu.

1. Click Start in the Taskbar, and then locate the GEAR Software and the 
GEAR PRO for Windows 9X/NT/2000 folder.

2. Click the GEAR PRO program icon. The main screen with the menu bar and 
project wizard appears and you can create a new project, open an existing 
project or copy a CD. The new project is saved in a virtual image file. A 
virtual image file is a file that contains all the information you need to create 
a CD.

click to start GEAR
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Create your CD

When creating a disc, there are five basic steps to follow:

1. Select the type of disc to be created. 

2. Set the appropriate parameters.

3. Select the data you want to write to disc.

4. Select the appropriate recording media device.

5. Test and write the project.

For more information, see Working With Projects (Windows 9X/NT/2000) 
on page 67. 

The GEAR Menu

GEAR PRO has a main menu and a toolbar. The menu consists of the 
following:

1) The File menu includes New, Open and Close Project, appending of 
sessions and Delete Project, Generate Log File, Run Batch File, Run 
GEAR Command and lastly, Exit.

2) The Edit menu allows you to create new folders, rename,delete and to 
manipulate files and folders, Play Audio, Declick and Normalize audio, 
Create a new Track and to Go one level up.

3) The View menu defines type of Icon view, List and Details view.

4) The Project menu gives you access to the Volume Porperties, Current 
Track Properties, defines actions to be applied to tracks and physical 
images and allows you to Verify the volume or track

5) The Recorder menu allows you to eject the media, close the tray, gives 
you access to the Copy CD function, the CD-R(W) device, information 
about the media and to execute commands like write, test, erase. It also 
contains the settings dialog for the recorder.

6) The Tape and Juke box menus are disabled. If the tape and jukebox 
modules have been purchased, these menus will be displayed.
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7) The Options menu lets you change the preferences and Harddisk 
information.

8) The Window allows you to select which windows are actively 
displayed during the use of the program.

9) The Help menu allows you build an index and get information 
about the program and GEAR.

The GEAR Toolbar

GEAR displays the function of a button when you place your mouse 
on that button. The toolbar contains the following buttons:

How to ...?
The following paragraphs contain specific instructions for the 
creation of different CDs types.

How to create a ISO CD

The ISO type is most suited for the creation of CDs containing normal 
files for storage/archiving. You may also create hybrid ISO/UDF discs for 
greater compatibility with platforms using the UDF standard.

To create an ISO CD project:

1. Select New CD-ROM (ISO) on the GEAR project panel.

Append

Open a project Delete a project

Close a project

Get Disc Information

Burn a CD-R

new project
to existing
CD-R

Disc copy

Erase CD-RW

Tape control

Juke box control

Up one level

Test write Help

Explorer View

Track view
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2. Click the Create button to the right of the panel. The Create project 
window appears.

3. Select the appropriate project size in the Disc Size panel.

4. Enter a name for the project. GEAR automatically provides the 
extension. Note that the Project name will become the volume label 
for the CD.

5. Click Create. The Explorer view of your computer will be 
displayed at the top half of your screen. The bottom half displays 
the view of the volume you are about to create. The first branch in 
the tree view show a data track.

6. You can now drag files and/or folders from the computer view into 
the empty track view. As you do so, the statistics such as date and 
start sectors will be displayed. If the log view is enabled, you can 
monitor the actual copying. We recommend to close the log view if 
you are copying large amounts of data, this will speed up the 
overall operation.

7. If you select Settings next to the close button on the GEAR Project 
panel line, you can set the media catalog code (UPCEAN) by 
changing the volume settings (Optional, normally used by 
publishers).

8. Once you have completed the copying of all files onto the track, 
select a device to write the project to from the Output Device panel 
at the bottom of the window.

9. Click Settings if you need to change any of the settings of the 
device. 

10. Click Test to test the project. GEAR will ask you if you want to 
write immediately after a successful test.

11. Click Yes. GEAR starts testing and writing. If there are any 
problems, GEAR will notify you and give you the opportunity to 
solve the problem.
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12. Close the project by clicking on the Close button next to the GEAR 
Project panel.

How to create a CD-Tape

1. Create an ISO project as described above.

2. Select a tape device in the device panel.

3. Click Settings to check the tape settings. See page 87 for 
detailed information.

4. Click Write. 

5. A dialog prompts you with instructions for preparing the tape 
unit for recording. When the unit is ready, click OK.
When GEAR has finished writing, a premaster tape is ejected. 
The tape can now be sent to a CD mastering and replication 
plant.

How to erase a CD-Rewritable

GEAR supports the creation of CD Rewritable discs. CD Rewritable 
(CD-RW) is a CD technology which enables you to erase recorded 
information and write new data in its place. You can use a CD-RW 
recorder to write both CD-RW discs and CD-R discs. Only CD-RW 
discs can be erased, however. 

To erase a CD-RW:

1. Insert the CD-RW in the CD-RW recorder.

2. Click the Erase CD button in the toolbar.

There are two options, Total erase and Quick erase. In the case of 
Total Erase, the complete CD-RW will be erased. Quick Erase only erases 
already written sessions. In either case you can now reuse the CD-RW for 
new projects.

Warning! Be sure you do not need any of the data on the CD-RW before erasing 
it. Erased data cannot be recovered. If you start to get read/write errors, try to do 
a Total Erase to see whether it will correct the problem.
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How to create a CD-ROM (XA)

Basically, you create CD-ROM and CD-ROM XA projects in the same way. The main 
difference is that in a CD-ROM XA project the files have to be pre-interleaved. For 
more information on CD-ROM XA, see page 39.

1. Select “New CD-ROM XA” in the DVD/CD GEAR Project panel.

2. Click Create. The Create project window appears. 

3. Enter a name for the project. GEAR automatically provides the extension. 

Remember that the Project name becomes the CD volume label.

4. Select the maximum size of the project according to your CD-R disc size.

5. Click Create to close the dialog and create the new project. A valid ISO name 
may consist of up to eight alphanumeric characters and underscores (_). For 

information about valid ISO-9660 names, see the File and Directory Naming 
section in the Appendix D.

You are now ready to start loading the contents of the project.

6. In the GEAR Explorer view drag the files and folders from the computer view 
into the volume view (from top right panel to bottom right panel in the explorer 

view). Continue to select and load files for the project until your project is finished.

Enter a name for 
your new XA 
project

Choose the disc size

Click here to 
create your new 
project
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7. Select the device you wish to write to in the output device panel. You may 
modify the settings as desired or required. You are now ready to write the 
project to the media.

8. Click Test to make sure no buffer underrun will occur during the actual writing. 
Gear will ask you if you want to write immediately after a successful test. (If 
you have successfully made a disc before, you may want to skip the test phase 
and click instead on Write).

9. Click Yes to write after testing the project.

10. Click on Close nect to the GEAR Project panel.

How to copy a track to hard disk

GEAR lets you extract tracks from a CD and store them on your hard disk for recording 
on a CD-R. 

Note: Not all recorders support copying digital audio tracks. Only tracks can be ripped. For 
more information, visit our website www.gearsoftware.com

1. Insert a CD in your CD recorder.

In the Drive 
window, locate and 
select the files...

Choose the drive 
you want to load 
files from

 ... then drag 
them to the 
volume window



GEAR Software

56 How to ...?

2. In the main toolbar, click the Disc/Track View button to display a window 
containing information about the CD, such as the track types used. (You can also 
use the disc info icon to get the track information. Select the track to be copied, 
then right click and select “Copy Track(s)”. A window will pop up and prompt 
you for a destination to store the track onto the hard disk.).

3. Choose the track you want to copy and drag it into the volume window. A 
window will pop up and prompt you for a destination to store the track on the 
hard disk.

4. Continue until all tracks are copied into the Volume window.

5. Select the device you wish to write to in the output device panel. You may 
modify the settings as desired or required. You are now ready to write the project 
to the media.

6. Click Test to make sure no buffer underrun will occur during the actual writing. 
Gear will ask you if you want to write immediately after a successful test. (If you 
have successfully made a disc before you may want to skip the test phase and 
click instead on Write).

7. Click Yes to write after testing the project.

8. Click on Close next to the GEAR Project panel.

How to make a copy of your CD-ROM

There are three ways to copy a CD-ROM:

• Use the “Copy CD” button from the wizard screen or menu bar

• Copy a Data CD from your CD player to the CD recorder or

• Copy any CD to hard disk and then from hard disk to the CD recorder

Copying a CD-ROM using “COPY CD”

Copying a CD using the “Copy CD” button form the wizard, recorder menu or menu bar 
is very simple. Just insert the CD to be copied into the CD-ROM or CD-R recorder and 
follow the simple instructions. If you copy from the CD-R to the CD-R recorder you 
will be asked to insert a blank CD once the disk has been read into one of your hard 
drives (temporary storage will be freed up when the copy completes).
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You can select either your CD-ROM or CD-R(W) drive as the source. If you select the 
CD-ROM as source you may find that with certain types of disc you will not get exact 
copies od the CD. If that is the case, use the CD-R(W) device as your source and 
destination.

Copying a CD-ROM from CD reader to CD recorder

If you don’t have enough temporary storage you can use this method to copy a CD. 
Copying a CD from the CD-ROM player to a CD recorder is possible only if you have 
a SIX speed or faster CD-ROM player and if your system runs well with cyclic 
buffering. The advantage of this option is that you do not need much free space on 
your hard disk (Note your computer has to be fast enough to avoid under runs).

1. Insert a Data CD in the CD-ROM player and the blank CD-R in the recorder.

2. Select ISO CD-ROM in the project panel.

3. Click Create.

4. Enter a name for the project. 
Use the same name as used in the original CD (watch out for capitals).

5. Click Create. The Explorer view appears.

6. Select your CD-ROM drive in the Drive window. The content of your CD-ROM 
is displayed in the right window
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7. Drag and drop the files you want to copy from the Drive window to the Volume 
window.

Now you can test and write the project to the CD-R(W) as shown in the previous 
examples. 

Note: If you get a buffer underrun, your CD-ROM player is not fast enough. To correct the 
problem, lower your recording speed (4 to 2, or 2 to 1) or convert your project to physical by 
clicking Convert to Physical in the Project menu. Before writing to CD-R enable the Use 
Physical image check box in the Recorder Settings screen.

How to create an Audio CD

Th following procedure explains how to create an Audio CD from wave files and/or 
Audio tracks. Use a CD track list to create an Audio CD from Audio Tracks only. One 
of the advantages of using a CD track list is that you can specify the pause between the 
tracks. For more information on Audio CDs, see page 40. For more information on CD 
track lists, see page 43.

To create an Audio CD:

1. Select CD-Audio as Type in the Project panel.

2. Click Create to create a new project. You will prompted to enter a project name 
and for a directory to store the project into (Default is the GEARLiteImg 
directory).

3. Enter a name for the new project. GEAR automatically provides the extension. 

4. Choose the appropriate project size. 

Enter a name for your 
new Audio project

Choose the disc size

Click here to 
create your new 
project



How to ...? 59

G
etting started in W

indow
s 9X

/N
T

/2000

6

5. Select the directory and drive where you want to save the new project file

6. Click Create to close the dialog and create the new audio CD project.
The Explorer view appears. 

7. In the Drive Window, locate and select the files you want to load, then drag them 
to the Volume window. You will see that a new Audio track is created 
automatically for each file you drag into your Volume/Track window.

Note: You can copy tracks from an audio CD directly in your project. To do this:

• Click the Disc/Track View button in the menu toolbar. A CD information 
window appears with information about the audio CD.

• Click on session 1 in the device window (top left). The top right window 
will display all the tracks on the CD.

• Then drag and drop the tracks you want to copy from the CD information 
window to your Volume/Track window. GEAR will create a physical image 
on your hard disk of all these tracks (You will be prompted for a destina-
tion on the hard disk for each track).
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8. Continue to select and load tracks or files for the project until your Audio CD is 
finished.

9. Select the device you wish to write to in the output device panel. You may 
modify the settings as desired or required. You are now ready to write the project 
to the media.

10. Click Test to make sure no buffer underrun will occur during the actual writing. 
Gear will ask you if you want to write immediately after a successful test. (If you 
have successfully made a disc before you may want to skip the test phase and 
click instead on Write).

11. Click Yes to write after testing the project.

12. Click on Close next to the GEAR Project panel.

Note: If you record the tracks in more than one recording session make sure Disc fixation is 
disabled until the last session.

In the Drive window, 
locate and select the 
tracks or files you 
want to write to CD ...

Choose the 
drive and files or 
CD and session 
you want to load 
tracks from

 ... then drag them to 
your Audio 
track window

Disc/track View button
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Writing your Audio CD in several sessions

Audio CDs should be single-session discs because CD players are single-session 
readers, which means you cannot finalize an audio CD until you have loaded all the 
audio files for all the tracks. You must therefore un-click/disable the “Close disc as 
Multi-session” and Fixation options in the Device panel until the last track has been 
recorded to CD-R. The CD-R cannot be played in a CD-ROM or CD player until it 
has been fixated, but you can click the Disc Info button to see what is already on the 
disc.

Note: Writing Track At Once can result in an Audio CD with sharp clicks between the 
tracks. You should only write in more than one session if you do not have enough hard disk 
space for all the tracks.

1. Start with selecting “New CD-Audio” from the GEAR Project panel.

2. Load the Audio tracks as described above. You cannot change the pause with 
Track-At-Once writing (standard 2 second pause between tracks).

3. In the CD recorder settings, disable the Multi-session and disc fixation options 
and choose Track-At-Once.

4. Write the audio tracks to CD-R. 

5. Repeat steps 1 to 4 until you have recorded all the Audio tracks. 

6. Once you have finished adding Tracks or the CD is full, select Fixate disc in the 
Tools menu to manually fixate the disc. This turns the CD-R into a normal 
audio CD which can be played in any player.

How to create a Multi-session CD

You create a multi-session disc the same way as you would create a CD-ROM, but 
with one exception: “Close as Multi-session” must be enabled in the Recorder/device 
Settings.

1. Create a CD-ROM project as described in the procedure earlier this chapter. 

2. In the Output Device panel, click Settings. The CD Recorder Settings window 
appears.

3. Set the Recording Method field to Track-at-Once.

4. Enable the “Close as Multi-session” checkbox.

5. Enable fixation (if you want to be able to read the CD between adding/appending 
sessions.
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6. Click OK. The Explorer view reappears.

7. Click Test to start testing and writing. GEAR will ask you if you want to write to 
CD-R(W) after the test has been successfully completed. 

8. Click Yes. Once the writing session has been completed, the Mult-session CD-
R(W) can be used in a CD player capable of reading Multi-session CDs. You can 
add new data by appending a new session to the disc.

How to change the append mode

Proceed as follows to change the append mode:

1. Choose Preferences in the Options menu.

2. Select the Append tab in the Preferences dialog.

3. Select an Append mode and click OK. 

How to append data to a multi-session CD

The procedure described below is based on use of Automatic Append mode. Where 
relevant, details on the other append modes will be added. 

When you append a session to CD-R the selected session/track is read and a new virtual 
image is created. The virtual image contains the same directory/file structure as the 
session and is displayed in the project window.

To append data to a multi-session disc:

1. Insert a multi-session capable disc into the recorder. 

2. Select “Add new session to CD” in the GEAR Project panel. The button 
immediately next to the panel changes to Append. Alternatively you may use the 
File/Append session option from the main menu.

3. This step applies to manual append mode only or if the setting is “append new”. 
Click Append. The AutoAppend Track window appears. The last recorded 
session is automatically selected. You will be prompted for a new Volume name 
and to select Data 1,2 or Audio type of session to append.

4. Make your selection according to the type of CD you wish to create and Click 
OK.

Note: If the same recorder has been used to create or append to the disc, it could be that 
the image file still exists. In that case GEAR will display a message. 
Click Yes to overwrite the volume.
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The GEAR information window appears. Note that the buffer indicator in this 
window will only be active if cyclic buffers are used. 
GEAR will now read the track data.

You are now ready to select the files you want to add and/or remove. The Explorer view 
is described in Loading files on page 72. Be aware that by removing a file, you only 
delete the entry. Although the data is not erased, it can no longer be retrieved.

After selecting the session contents, you can proceed to Test and Write. Only 
changes will be written to the CD-R disc. Every time you write a new session, an 
additional 15MB is added to the CD-R disc. This is known as overhead. Once you 
have completed the operation you may select Close in the GEAR Project panel to 
close the project.

Appending manually

If the append mode is set to AutoAppend, GEAR automatically selects the last 
session/track on the CD to append the new data to. In order to be able to select the 
appropriate session/track yourself, you must set the append mode in the GEAR 
Options/Preferences/Append to Manual Append. 

To select a session/track:

1. Insert a multi-session capable disc in the recorder. 

2. Select “Add new session to CD” in the GEAR Project panel.

3. Set the Append mode to manual under the Append Tab in Options/Preferences.

4. Click on the Append button in the GEAR Project panel.

5. Select the track/session to append to. If you delete any of the original files, the 
data will become inaccessible once the new track/session has been completed.

6. In the explorer view drag the files to the volume window. 

7. You can now start Testing and Writing.

How to create a CD with an external image

Although you cannot edit external images with GEAR, you can use GEAR to write 
them to CD-R.

To create a CD with an external image:

1. Select “Open external physical image” in the GEAR Project panel.

2. Click on Open next to the GEAR Project panel.
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3. The Open External image dialog appears.

4. Locate the external image you want to open, then click Open.

5. Choose the appropriate format from the Image Type drop-down list. 

6. Click OK. The Explorer view appears.
Now you can test and write the project to the CD-R(W). 

For more information on predefined images and external images, see page 42.

How to create a premaster tape

To create a premaster tape (requires Tape option):

1. Open a project.

2. Select a tape drive in the Output Device panel

3. Click Settings to check the tape recorder settings. The Tape settings dialog will 
appear. This dialog has tabs for CD mastering, as well as tabs for General, 
customer and SCSI settings. You may need to confirm certain settings with the 
person or company doing the actual mastering of your image. The deaulf it DDP 
format.

4. Click the Write button.

5. A dialog prompts you with instructions for preparing the tape unit for recording. 
When the unit is ready, click OK.

For more information on premaster tapes, see page 87.

How to create a physical image of a project

To convert a project you must:

1. Select “Open existing project” from the GEAR Project panel. 

2. Click on Open next to the GEAR Project panel. Select the project from the list.

3. In the menu bar select Project and then “Convert Volume to Physical” or Convert 
Current Track to Physcal”.

The progress of the conversion process is displayed in the GEAR information 
window. 
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4. If physical files already exist for the project, you are prompted to overwrite them. 
GEAR displays a message once the physical image has been successfully 
created.

For more information on physical images, see page 83.
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Working With Projects 
(Windows 9X/NT/2000)

This chapter provides detailed information about working with GEAR CD 
projects and writing them to CD-R. This chapter handles the following topics:

• General information about projects

• Creating and opening a project

• Editing the project contents 

• Changing project settings and preferences

• Using a physical image

• Recorder Settings

• Testing and Writing to CD-R(W)

About projects
GEAR projects contains all the information needed to create a CD. When you 
create a new project, a number of administration files are created in the current 
working directory:

• a volume administration file with the extension .vol

• track administration files with the following extensions .mxx, .ixx, .fxx, and 
.vxx, where xx stands for the track number.
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Together the administration files described above form the virtual image. GEAR 
uses this image during the writing of a CD-R(W). Administration files are deleted 
automatically when you delete the associated image.

Note: You should never edit, delete or otherwise modify the administration files manually. 
This will result in a corrupted and thus useless project.

Hard Disk Space Required

You must have at least 25 Mb of free disk space available to create a CD-R project.

If you use a physical image file to solve writing problems (see page 84), the entire 
CD contents is stored on hard disk. In that case you may need up to 807 Mb of free 
disk space. On page 68 you will find a table of disc capacities

GEAR preferences

The GEAR preferences can be found under the Options menu and are saved in the 
gear.ini file. They will be the default values for each new project you will create. 
You can edit the following settings:

• Project defaults; settings used when loading files. Please note that this version 
of GEAR PRO supports Rockridge extensions so you can also read the CDs on 
Unix systems.

• Default CD label settings; project information that can be written to CD-
R(W).

• Working directory; directory where the project file is saved.
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To change the GEAR Preferences, you must 

1. Select Preferences from the Options menu to display the Preferences dialog. 
The Preferences dialog appears. 

2. Make all the changes you want, then click OK to save the preferences to 
the gear.ini file.

Opening a project
There are two ways to start a project:

• Create a new project

• Open an existing project

Change these settings before 
creating a project
Max Dir nesting level lets 
you specify up to 24 levels 
of nested directories you can 
have on the CD

When this is turned on, 
GEAR loads into the project 
files that have the DOS 
archive bit set.

This lets you 
specify how 
invalid ISO 
names will be 
handled for the 
project

…when this is turned on, 
GEAR resets the DOS 
archive bit after the file is 
successfully loaded

This lets you 
hide the 
directory in the 

GEAR window
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Creating a new project

When you start GEAR, the main menu, toolbar and Project panel appear. You can 
create a new project as follows: 

1. Select the appropriate type in the GEAR Project panel, the default is “New 
CD-ROM (ISO)”.

2. Click Create. The Create Project window appears. 

3. Enter a name for the project. GEAR automatically adds the extension. 

Note: .A valid ISO name may consist of up to eight alphanumeric characters and 
underscores (_).

Choose the Project/
CD type

Enter a name for 
your new project Choose the disc size

Click here to 
create your new 
project
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4. Select the maximum size of the project according to disc size and track type:

5. Click Create to close the dialog and create the new project.
You are now ready to start loading the contents of the project using the 
Explorer view.

Opening an Existing Project

To open an existing project:

1. Before you open a project, you must first close any open project.

2. Click the Open CD Project button in the toolbar.
The Open Project dialog appears.

3. Locate and double-click the project you want to open. The Explorer view 
will be displayed.

The selected project is expanded to the maximum free space available. This 
space is determined by:

Data Capacity & Disc Size

Type ISO and 
ISO/UDF

XA and CD-I CD Audio

CD-R(W) 18 min. 158 Mb 180 Mb 181 Mb

CD-R(W) 63 min. 553 Mb 631 Mb 653 Mb

CD-R(W) 74 min. 650 Mb 741 Mb 746 Mb

CD-R(W) 80 min. 703 Mb 802 Mb 807 Mb

DVD-R 428 min. 3.95 GB

DVD-R 509 min. 4.7 GB

Locate and select the 
project you want to 
work with ....

... then click Open
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• The appropriate disc size specified when the project was created

• The amount of space required by the other tracks within the same 
project

An existing project can be one of the following:
• A GEAR project file, which can be edited in GEAR and written to CD-

R(W).

• An external image file, which cannot be edited, but only written to CD-
R(W).

Things to remember

As you create your new project, you must keep the following in mind:

• The track number is assigned automatically and is relevant only for CD Audio. 
With the exception of CD Enhanced and CD Plus, ISO and XA tracks are 
always assigned to track number 1.

• A project can have only one ISO or XA track; it may not have both types of 
tracks.

• A project can contain up to 99 tracks.

• If you create a CD Enhanced, first create an Multi-session CD with all the 
Audio tracks, then append a second session with either an ISO or XA 
track.The audio player will ignore the data track and the CD-ROM player will 
ignore the audio tracks.

• When you create a new track, it is automatically assigned the maximum 
available space in the project.

Project Contents

Loading files

You can load the data for your project by selecting files in Your Drive window and 
dragging them to your Volume/Track window. To increase CD-ROM access time, 
limit the number of directory entries to 50.

To load files you must: 

1. Open or Create the project you want to edit.

2. Click on the Explorer or Disc/Track view button to open the appropriate 
windows. 

The Explorer view window appears.
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3. In the Drive Window, locate and select the files you want to load, then drag 
them to the Volume/Track window.

File name handling

DOS recognizes file names of up to eight characters; file names can have a three-
character extension. Other systems are not limited to this restriction. For data 
tracks only, you can determine how and when non-ISO file and directory names 
are translated with the File Name handling buttons. You can change the default 
setting in menu under the “Project/Current Track Properties/Files and 
Directories” tab. See the File and Directory Naming section in Appendix D for 
more information on ISO standards.

Note: Use the option ‘Translate to Uppercase only’ when you want to be able to read the 
file names under DOS and Windows 95/NT.

Editing the project contents

You can edit a selected project in the following ways:

• Create a new directory/folder on the track

• Rename a file or directory on the track

In the Drive 
window, 
locate and 
select the files 
you want to 
write to CD ...

Choose the 
drive you want 
to load files 
from

The project name is displayed at the top 
of the window

 ... then drag 
them to your 
Project window
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• Delete selected files and directories from the track

• Restore from the project directory.

First, however, you will find information on 

• Selecting and deselecting files and directories

• Loading hidden files.

Selecting and Deselecting Files and Directories

In the Volume window you can select one file or directory, or you can select 
multiple files and directories to rename or delete. 

Loading Hidden Files.

To load hidden files:

1. Turn on the Load Hidden files check box in Options/Preferences/Project 
Defaults.

2. Select the files and directories you want to load and drag them to your 
GEAR Volume/track window.

Hidden files will be loaded until you turn off the check box.

Creating a New Directory

To create a new directory:

1. Open the project you want to edit by selecting “Open existing GEAR 
Project” in the GEAR Project panel.

2. Click Open. The Project selection window appears. Select the project you 
wish to edit and click on Open. The Explorer view will appear.

To do this… Do this…

Select one file/directory Click the file or directory to highlight it

Select multiple files and 
directories

Click the first file or directory, then Shift+click subse-
quent consecutive files or directories. 

You can also select multiple files with Ctrl+click.

Deselect selected files or 
directories

Click on the selected file or directory
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3. Move the mouse in the Volume/Track window and right click. A dialog will 
pop up giving you several options, including “New Folder”. Click on New 
Folder.

4. In the dialog that appears next to the folder icon, enter a valid ISO name for 
the new directory.

A valid name may consist of up to 30 uppercase, alphanumeric characters 
and underscores (_). (DOS can handle only up to eight characters.) For 
information about valid ISO-9660 file and directory naming, see the 
File and Directory Naming section in Appendix D.

5. Press the Enter key to complete the entry. 

The new directory appears in the working window.

Renaming Files and Directories
1. In the Volume/Track window select the file or directory you want to 

rename.

2. Right click and click on Rename in the dialog box.

3. In the dialog that appears next to the file or folder icon, enter a new name 
for the specified file or directory, then press Enter to complete the entry.

4. Repeat for each selected file or directory if you wish to rename.

Deleting Files and Directories
1. In the Volume/Track window select the files and directories you want to 

delete.

2. Right click and click on Delete in the dialog box.

3. Repeat for all the files and folders you wish to delete.

Changing the Project and Recorder Settings
Before you proceed to test and write your project, you are advised to check the 
settings relevant to your project. 
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Project Settings

You can edit the settings for the currently selected project. The default values are 
specified in the gear.ini file and can be changed using the tabs under Preferences in 
the Options menu.

• You can edit the CD label for the currently selected project. The default CD 
label is the name the project received when created.

• You can edit the File and directory defaults

• You can indicate the Append mode, if applicable

• Under Options, you can change the working directory for projects

Note: Most of the project settings can be set directly in the main window. Only the 
maximum number of directories and the directory nesting must be set here.

For detailed information about the settings, see The gear.ini and Preferences File 
on page 131.

To change the project settings:

1. Select Options/Preferences. The four tabs in the Preferences menu appear. 
Select Default CD Label..

2. Enter the information you want to save with the project in the Current CD 

Label and click on OK.

3. Select the settings for the loading of files in the Project Defaults. 

4. Click OK to close the Preferences menu and return to the main menu screen.
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Recorder Settings

You can specify the types of settings appropriate for your CD recorder using the 
Recorder/Settings menu or the Settings button in the Output Device panel. There 
are three types of settings:

• CD Settings

• Advanced

• SCSI

To change the recorder settings:

1. Click the Settings button in the Output Device panel or Recorder/Settings 
menu. The CD Recorder Settings dialog appears.

2. Select the recording settings you want to use.

3. Click OK. The dialog box closes and you return to the main screen.

CD Settings

In the CD Settings, you can do any of the following:

• Select a recording method: disc-at-once or track-at-once, other methods 
depend on your recorder model. 

Disc at once means your recorder writes the lead in, then the track data, then 
the lead out in one continuous flow. This method is especially suited for 
Audio recording.

Important: You cannot use disc at once recording to record a multi-session disc.

Track at once means your recorder first writes the track data, then finalizes 
the disc by writing a lead in and lead out. This method is used in multi-
session recording.

• Specify the speed at which you want to record: 1x, 2x, etc. depending on your 
recorder model. You may select separate speeds for Audio reading. Quite 
often a lower Audio read speed results in better quality.

• Verify the data after writing your project to CD-R(W).

• Use a physical image file for recording. A physical image is a bit-by-bit copy 
of the CD-ROM you are about to create. (See page 80 for a description of a 
physical image). If the test run fails, you can convert your virtual image to a 
physical image and use it by checking the box. If you did not create a physical 
image, GEAR prompts you to use the virtual image instead.
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• Enable the Close as Multi-session option. If you want to be able to append 
other sessions to your CD-R(W) you will also have to choose Track at Once 
recording and enable Fixate disc. 

• You can also specify whether to fixate the disc after recording (that is, record 
the lead in or lead out). If you do not fixate the disc, you can specify a multi-
session recording, that is, recording can occur over several different sessions 
on the same or different recorders

Important: Some of the older CD-ROM players do not support the reading of multi-ses-
sion discs.
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Advanced Recorder Settings

In the CD Recorder Settings dialog for Advanced Recorder Settings you can do any 
of the following:

• Enable writing past 74 minutes. This option can be used with either 74 or 80 
min. media. Most media has some additional space available for a few extra 
sectors of Data or minutes of Audio.

• Eject the disc on completion of the writing process.

• Allow to write using Burn Proof. Some recorders support this feature 
which guarantees to create a disc without under run errors.

• You can manipulate the write and read buffer sizes by moving the sliding 
buttons. Depending on the speed of your computer, recorder and hard disk. 
We have found that for CD-R recorders the default of 256 KB works well.

• Select the number of copies you wish to write of the same image.

• Select the number of sub writers (for Sony CDW900)

.
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SCSI Settings

In the CD Recorder Setting dialog for SCSI Settings, you can specify the Interface 
driver and buffering settings. When you change the SCSI settings GEAR may 
prompt you to reset the SCSI bus. Click OK to reset the SCSI bus. The maximum 
transfer block or buffer size for SCSI is a little less than 64 KB (65280 bytes).

Note: A special feature of the GEAR windows 95/98 software is the use of Cyclic 
buffering during the recording. You can change the number of buffers and their size to 
decrease the chance of a buffer underrun while writing.

The driver uses Cyclic buffering or double buffering. Depending on the recorder 
type you may only be able to use Cyclic buffering and the other choice will not be 
displayed. Double buffering should never be used if the Recorder and the hard disc 
share the same SCSI bus (which is typically the case, unless you have multiple 
SCSI cards or a card with two independent buses).

The Host adapter and TargetID are set by the system.

The buffering concept is explained in the next section. The default settings have 
been tested with a wide variety of drives and computers. You may however 
experiment with different settings if you encounter problems writing discs.
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Testing and Writing

About Data Transfer

The writing of a CD-R(W) is a continuous process in Disc at Once and Track at 
Once modes. Therefore the system has to maintain a high data transfer rate to the 
recorder. If the transfer rate cannot be maintained, the writing will fail. CD-
R(W) discs can be written at different speeds, DVD-R discs are typically only 
written at 1x speeds. The data transfer rate is dependent on the speed of 
recording and the type of track written (ISO, CD-ROM XA, or CD digital 
audio). The following table shows the required transfer rates:

For external images, the required transfer rate depends on the selected sector size. 
2048 bytes/sector is comparable to ISO; 2336 bytes/sector is comparable to CD-
ROM XA; 2352 bytes/sector is comparable to CD digital audio.

Buffering

GEAR creates the virtual image of the project that is written to CD-R(W) just 
before actually writing it. An interruption in the flow of data to your CD-recorder 
would cause a write failure and the loss of your CD-R(W). To ensure a steady 
flow of data GEAR fills buffers with data. As GEAR writes data to the CD-R(W), 
the GEAR information window provides you with information on the percentage 
of each track written to CD-R(W) and the percentage of data remaining in the 
buffer. The read and write buffer size ranges typically from 256 KB to 1 MB. The 
read buffer is filled from the SCSI buffer in blocks of its size. A similar process 
applies to the write buffer, in this case the SCSI buffer is filled from the write buffer 
and then written to the CD or DVD.

A special feature of the GEAR PRO for Windows is the use of Cyclic buffering 
during the recording. You can change the number of buffers and their size to 
decrease the chance on a buffer underrun.

1x 2x 4x 6x

ISO 153 KB/s 307 KB/s 614 KB/s 918 KB/s

CD-ROM XA 175 KB/s 350 KB/s 700 KB/s 1050 KB/s

CD Digital Audio 176 KB/s 352 KB/s 705 KB/s 1056 KB/s
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Testing

Before you start recording your disc there are several tests you can perform to 
ensure successful writing:

• Verifying your project

• Testing transfer rate

• Test-mode recording

Verifying a project

When you verify a project, GEAR checks the size, date, and time stamp for each 
file in the track or project. If there are discrepancies, it usually means a file has been 
updated since it was loaded into the project and GEAR prompts you to update the 
project. 

GEAR automatically verifies a project when you start writing to CD-R(W). 
However, you can always verify a project manually:

1. With the project you want to verify open, choose Verify Volume from the 
Project menu.

2. If verify reported that files and/or directories have changed since being loaed 
into your project, update the project by reloading the reported files and 
directories.

As GEAR verifies the track or project, the status of the verification is reported 
in the GEAR information window.

Note: If you selected ‘Verify after write’ in the Recorder Settings, GEAR automatically 
verifies the written CD-R(W) against the project on hard disk.

Test write GEAR Project

You are advised to check your system’s performance before you start writing, 
especially for the first few discs you will write. GEAR tests whether it can read all 
the information from your hard disk and write it to the CD recorder. The data is not 
actually written to the disc.

To test the transfer rate:

1. Open the project you want to test

2. Click on Test next to the Output Device panel at the bottom of the main 
screen or select Test Write from the Recorder menu. A GEAR dialog appears 
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where you can choose to write the CD-R(W) immediately after a successful 
test.

No data is transferred to the recorder during this process. If parts of the image 
cannot be read fast enough, GEAR warns you. For tips on improving your system’s 
performance see Improving System Performance on page 83.

Note: Some recorders do not support test-mode recording. 

Improving System Performance

You can try any of the following to optimize your system’s performance:

• Close any other software applications you are running in the background. 
e.g. Anti-virus software, screen savers, or any other software that may 
attempt to access the hard disk while GEAR is recording.

• Use a defragmentation utility to defragment your hard disk.

• Check to see whether your hard disk does recalibration.

• Check to see if your SCSI termination is correct. An incorrect SCSI termi-
nation can cause delays on the SCSI bus.

• Use a physical image instead of a virtual image.

• Use a lower recording speed if one is available.

Note that the performance of a system for writing a CD-R(W) is better if the 
access time of your hard disk is lower. This is more important than a fast 
processor. A lot of hard disks regularly perform recalibration. 

This means that the hard disk verifies its read/write operation to prevent 
problems. If this happens during the writing of a CD-R(W) disc, it may result in 
a data transfer problem.

More tips about improving system performance can be found in Troubleshooting 
on page 151. 
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Using a Physical Image
A physical image is a bit-by-bit copy of the CD-ROM you are about to create. You 
should use a physical image for writing to CD-R(W) when the transfer rate for 
recording has to be increased. Otherwise, you can usually write your project with 
a virtual image.

To convert a project you must:

1. Open the project you want to create a physical image for. 

2. Select Convert Volume to Physical from the Project menu.

3. If physical files already exist for the project, you are prompted to overwrite 
them.

GEAR displays a message when the physical image has been created 
successfully.

Before you create a physical image, GEAR verifies the project. If the file is not up 
to date, the physical image is not created. You can update the project by reloading 
the reported files.

Depending on your needs, you can make a track or an entire image physical. The 
sector sizes for the tracks are based on their type as follows:

The physical image you create contains the current contents of the project. 
Subsequent changes you make to the project do not affect the current physical 
image.

The physical image file names are <volume name>.pxx.md*, where xx stands for 
the track number. These files are always written to the GEAR working directory.

Track Type Sector Size

ISO 2048 bytes

CD-ROM XA 2336 bytes

DA 2352 bytes
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Writing to CD-R(W)

Writing to CD-R(W)

To write the project to CD-R(W):

1. If necessary open the project you want to test by selecting “existing GEAR 
project” and by clicking on the Open button GEAR Project panel.

2. Choose your CD recorder from the pull-down menu in the Output Device 
panel.

3. Click Write in the Output Device panel. When writing is complete, the disc 
is ejected automatically (if the eject checkbox is checked). Your disc is 
ready for reading in any CD-ROM drive!.

Files Created After Writing to CD-R(W)

The CD-R command always creates the following files after you write a CD: 

• wo_ident.txt 

• woresult.txt.

The wo_ident.txt file contains the table of contents (TOC) and some customer 
information that is written to the CD recorder. The customer information is read 
from the gear.ini file. The woresult.txt file contains status information.

Using a jukebox
Tape and Jukebox are an add-on options for GEAR PRO. 

A jukebox  or medium changer is a robotic unit that can store and automatically 
load CDs into a CD-ROM player or a CD Recording unit. 

Use the Ouput 
Device panel to 
choose the output 
device to write to 
and to select the 
Recorder Settings



GEAR Software

86 Using a jukebox

To load a CD from the Jukebox:

1. In the GEAR main menu, select Jukebox Control. The Jukebox Control 
window appears (If a jukebox is present in your system).

2. To load a new disc into the jukebox drag the mailbox icon to an empty slot or 
empty drive. You will be prompted to insert a disc. After the disc has been 
inserted it will be transported to the destination slot or drive.

3. Start recording.

If you want to use a jukebox to write several CD-Rs unattended, make sure they are 
loaded consecutively, beginning in slot 1. 

To unload a disc, drag the filled slot icon or filled drive icon to the mailbox. You 
will be prompted to remove the CD from the jukebox.

To move a disc within the jukebox system, drag the filled icon or filled drive icon 
to an empty slot or drive.

You may also use the right-click function to perform some of these operations. Just 
follow the instructions displayed in the pop-up dialog box.

The jukebox Settings dialog allows you set various options, depending on the type 
of jukebox being used.

For a list of supported jukeboxes visit our website at www.gearsoftware.com.
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Writing to CD Premaster Tape
For the production of CDs in a mastering and replication plant a premaster tape is 
used. Mass-produced CDs can be made from either a CD-R disc or a premaster 
tape. GEAR lets you create both. The most common format is the Disc Description 
Protocol (DDP) format.

GEAR supports most tape units that provide a SCSI interface. The preferred 
configuration is with an EXABYTE tape unit, a Hewlett Packard DAT unit, or 
a DEC DLT unit. Visit our website at www.gearsoftware.com for an updated 
list of supported tape recorders. If no tape is attached, the Output Device panel 
will display something like: “Tape : Null Tape device 0.00”. If you select that 
device no ouput will be written.

Writing a CD project to tape

The process for premastering a tape is just like writing to CD. Make sure your 
tape unit is connected to your computer and turned on and that there is a tape in 
the unit before you start GEAR. Before you proceed write your project, you are 
advised to check the tape recorder settings. Under NT you may have to 
temporarily disable the tape service to allow GEAR access to the tape device. If 
so, remember to re-enable the service after you exit GEAR. For additional 
information see The gear.ini and Preferences File on page 131.

Tape recorder Settings

You can specify the types of settings appropriate for your tape recorder using the 
Settings button in the Output Device panel. There are five types of settings, 
details on these tabs and options can be found in the GEAR.INI file description 
in Appendix C:

• CD Mastering

• General

• Customer

• SCSI

To change the tape settings:

1. Select your tape drive in the Output Device panel.

2. Click the Settings button in the Output Device panel or Tape/Settings menu. 
The Tape Settings dialog appears.
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3. Select the settings you want to use and click OK to return to the main screen. 
You may need to consult the person or company doing the mastering of your 
image to verify some of the settings.

CD -mastering Settings

In the CD-Mastering dialog, you can do any of the following:

• Check the Write in DDP format (most common standard used for mastering). 

• Set the tape file strategy. This depends on the selected mastering process. 
Options include; Tracks in separate files, Same type tracks in one file and One 
contiguous file.

• set the CD-ROM parameters. 
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General Settings

In the General Settings, you can select whether the Ident.txt file will be written to 
the tape. This file is sometimes required in the mastering process. You can also 
select to Verify the tape after writing and/or to eject the tape once the writing 
process completes.
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Customer Settings

In the Customer Settings, you can enter the information that is written to the 
tp_ident.txt file. Some mastering and replication plants ask you to supply this 
information.
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SCSI Settings

In the SCSI Settings, you can specify the driver and buffer settings. The Null 
device driver can be used for testing purposes. Other options include the use of 
double buffering or the NT Miniport driver (NT only).

Note: A special feature of the GEAR Windows 95/98 software is the use of Cyclic 
buffering during the recording. You can change the number of buffers and their size.

Note: There is an extra tab in the tape settings which allows you to configure the DVD 
Lead In Control data. This is required for DVD master production companies to ensure 
a proper image conversion from tape to DVD discs. Please consult with your production 
company before you modify any of these parameters.
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Writing a Premaster tape

To write the project to Tape:

1. If necessary open the project you want to test by selecting “existing GEAR 
project” and by clicking on the Open button GEAR Project panel.

2. Choose your Tape device from the pull-down menu in the Output Device 
panel.

3. Click Write in the Output Device panel. 

4. When writing is complete, the tape is ejected automatically (if the eject 
checkbox is checked). Your tape is ready for delivery to the mastering plant!

Note: If you want GEAR to verify if the tape has been written correctly, you must enable 
Verify after Write in the Tape Settings (see page 77).

Files Created After Writing to Tape

The following files are created after a project is written to tape:

• tp_ident.txt

• tpresult.txt

• DDPID

• DDPMS

• PQDESCR

The tp_ident.txt files contains the table of contents (TOC) of the project written to 
tape and some customer information. The DDPID, DDPMS, and PQDESCR files 
form the DDP information of the last project written to tape. You can write these 
files to tape by checking the corresponding boxes in the Common Tape Recorder 
Settings as previously described.

Use the Ouput 
Device panel to 
choose the medium 
to write to and to 
select the Recorder 
Settings
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Using Logs and Batch Files
This chapter provides you with information about creating and using batch files. 
You can read about the following:

• Creating and editing a log file

• Running a GEAR batch file

Creating and Editing a Log 

GEAR’s batch utility lets you run multiple GEAR commands automatically—
without ongoing interaction from you. The easiest way to create a batch file is to 
use the Generate Log command in the File menu to create the image once. This 
is particularly useful for incremental backups or if you have to create the same 
image periodically with updated files, a CD that is updated quarterly, for 
example.

As you create the image, the commands you use are saved in a log file. You can 
use this log file as a reference to create batch files, or sometimes you can edit the 
log file and use it as a batch file. You can also read the log file to check the image 
generation process.

Generating a Log File

1. Choose Generate Log from the File menu to display the Name of logfile 
dialog.

2. Enter a name for the log file or choose one under File Name.

3. Choose a location to save the file, then click Create.

If you select the option Show log in the Window menu, you will notice that 
Logging started is displayed in the Status window.

4. Perform the actions you want to save in the log file. Each action you 
perform is recorded in the Status window.

5. When you are finished, un-check Generate Log from the File menu. Logging 
stopped is displayed in the Status window.
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Editing a Log File

You can use a text editor such as Windows Notepad to look at the log file. All lines 
that are preceded by a semicolon are comment lines—these lines are ignored when 
you run the batch file.

If you add comments to the log file, remember to start the line with a semicolon (;). 
You can also add any GEAR formatting commands to the batch file (these 
commands correspond to the GEAR for Windows commands available in the 
menus). For a detailed list of available commands, see GEAR Commands on page 
111.

Running a Batch File

When you run a batch file, each command in the file is executed. You can use a log 
file you create using the Generate Log command in the file menu or you can use a 
log file you create manually in a text editor.

When you run a batch file, lines that begin with a semicolon or an unknown 
command will be ignored. If there are lines that have invalid or missing parameters, 
GEAR prompts you to provide the parameter.

1. Choose Run Batch from the File menu to display the Name of batch file 
dialog.

2. Locate and choose the log or batch file you want to use, then click Open.

Lines preceded by a semicolon (;) are comment lines—they 
provide information about the command lines in the log and are 
ignored when you run the batch file

Comment line

Command line
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3. GEAR prompts you to run the batch automatically using the default dialog 
values. Click Yes.

As the batch file is processed, its status is displayed in the Status window.

Running a batch as a startup-option

To run a batch file automatically when you start GEAR, you must run the 
following command:

GEAR.EXE <batch file> /A /X

(where <batch file> stands for the path and filename of the batch file, /A enables 
the automated mode and /X exits GEAR after completion of the batch. 

Please note that the batch file needs to be initiated from the GEAR software 
directory, because the program relies on several files in that directory. Failing to 
do so will result in errors.

Running a GEAR command

You can execute GEAR commands from the File menu using “File/Run GEAR 
Command”. The command syntax is described in Appendix B. Whenever you 
execute a command and you have the log view/window enabled (see Window 
menu), you will see the result on the screen and/or log window.
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Glossary

General terms

3DO A CD-ROM-based system in the same market segment as CD-I. Based on a RISC 
processor for optimum graphical performance.

access time The time a CD-ROM drive or hard disk needs to read and transfer data from disc 
to the target computer.

ActiveAudio™ A type of Enhanced CD. ActiveAudio is one of the approaches developers have 
taken to solve the problems that occur when you combine digital and audio data 
on one CD-ROM. ActiveAudio information is organized in this way:

• Digital data occupies the silence preceding track 1 (so called track 0)

• Audio data occupies track 1 and up

address The ID number of a device on the SCSI bus, or the location of a block of data 
in storage.

ADPCM Adaptive Differential Pulse Code Modulation. A method of compressed audio 
data storage. Instead of storing the signal, the difference between signals is 
stored. This means that only four bits per sample rather than 16 bits per sample 
are needed.

For CD-I, levels A, B, and C are recognized. B and C are also used in CD-ROM 
XA. The sample frequencies used to measure the audio signals are 37.8 kHz 
and 18.9 kHz for levels B and C, respectively. This brings the band width (the 
maximum frequency to be reproduced) to 17 kHz and 8.5 kHz. For level A, 
these figures are 44.1 kHz and 20kHz. Using ADPCM, a 16-fold reduction in 
storage requirements can be achieved (level C, mono).
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AIFF Audio Interchange File Format. It is a full-featured audio file 
specification that allows many programs on multiple platforms to share 
standards for audio storage. Electronic Arts published the AIFF 
specification in 1985. It started as a digital music instrument 
specification. Over the years it has been enhanced to provide compressed 
digital sound (AIFC).

alias records The stored information that tracks the locations of a file and its alias as 
well as the pointers to those locations.

ANSI American National Standards Institute. ANSI is a private, nonprofit 
membership organization that performs two functions:

• Coordinates the United States’ voluntary consensus standards sys-
tem

• Approves American National Standards

If you wish to contact ANSI, write or call: ANSI, 1430 Broadway, New 
York, NY 10018; (212) 354-3300.

ASCII American Standard Code for Information Interchange. A coding scheme 
that represents characters numerically. Almost every manufacturer uses 
the same coding for the first 128 symbols in the ASCII table. Different 
tables exist for ASCII numbers 128 through 255.

authoring Working method for modeling information. Examples of authoring 
systems include word processors and spreadsheets on a PC, and 
multimedia workstations for combining sound, video, images and text 
for real-time audiovisual presentations.

average seek time The average time it takes to locate data and position the drive head to that 
location. Average seek time is measured in milliseconds.

AVI Format for audio/video files defined by Microsoft for use under 
Windows. The limited compression means a fast computer system with 
a fast storage medium is required. AVI is not well suited for use with CD-
ROM.

BER Bit Error Rate. Defined as the number of correctly processed bytes before 
an erroneous bit is detected. For CD-ROM, the bit error rate is 10-12.

bit The smallest unit of information. (Bit is a contraction of binary and 
digit.) A binary digit has a value of 0 or 1.

BLER Block Error Rate. Compares the number of blocks with at least one error 
against the total number of blocks measured.
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block The smallest “chunk” of memory accessed or transferred by a disk drive. Usually 512 
bytes in size, it can be larger in multiples of 512. The number of bytes in a block is the 
same as block size.

blown session A CD-ROM recording session that is disrupted such that the recorder literally loses 
track, rendering the recording medium, a writable compact disc, unusable.

buffer A temporary storage area for data being transferred from one place in the computer 
system to another.

byte A symbol or character that consists of eight bits.

cache A temporary storage area for information used frequently by your system. You can set 
up cache in RAM or on your hard disk. Using cache speeds up system response by 
reducing the time it takes to locate requested information.

caching Used to store recently-requested information. On the next request for the same 
information, the system retrieves it from fast cache memory rather than from the 
slower medium.

CD Compact Disc. A non-magnetic, polished metal disk with a protective plastic coating. 
Used to store digital information, which can be read by an optical scanning device that 
uses a high-intensity light source—a laser—and mirrors.

CD-I Compact Disc Interactive. A system for presenting information such as text, images, 
and video, on a television screen. The standard is defined by Philips and Sony and 
described in the Green Book.

CD Plus A type of Enhanced CD. CD Plus is one of the approaches developers have taken 
to solve the problems that occur when you combine digital and audio data on one 
CD-ROM. CD Plus takes a multi-session approach:

• Audio data occupies session 1

• Digital data occupies session 2

CD Recorder These drives, along with specialized mastering software, allow users to make their 
own compact discs. 

CD-ROM Compact Disc, Read-Only Memory. Data is stored as pits on a disc surface, which 
are read by a laser in the CD-ROM drive. The data can be read and copied; data 
cannot be erased; new data cannot be added.

CD-ROM XA Compact Disc Read Only Memory Extended Architecture. The standard for 
CD-ROM to which a number of options from CD-I have been added. These include 
audio compression (ADPCM), multi-channel audio, file interleaving, user data 
(2336 bytes/sector), image compression, and so on.

A CD-ROM XA disc is a Mode 2 disc in which the data in located in Form 1 (2048 
bytes/sector) or Form 2 (2336 bytes/sector).
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CD standards The physical aspects of different CD types defined by Philips and Sony. 
The logical file format used on CDs is described in the ISO-9660 
standard. See Green Book, ISO-9660, Orange Book, Red Book, White 
Book, Yellow Book.

CDTcache A feature of CDT that allows you to set cache values and other options 
for an individual CD, as opposed to an entire CD-ROM drive. CDTcache 
Setup values override the values set in Drive Setup.

central processing unit 
(CPU)

The brains or “central switching station” of any computer.

DAT Digital Audio Tape. A 4mm tape format used for data storage.

data capture A method of converting data from non-electronic data carriers—paper, 
microfiche, artwork, and so on—into a form that allows processing by 
computer.

data 
compression

A technique for removing unnecessary information from data. For 
example, a repeating sequence can be stored as a value and the number 
of times it’s repeated.

data error Any discrepancy between the data recorded and the data read back.

data transfer rate A measure of how quickly data is supplied to the computer from the CD-
ROM drive.

DDP Disc Description Protocol. A CD sector level protocol designed to 
adequately describe a compact disc. A CD described using DDP can be 
reliably mastered. Some mastering and replication companies prefer the 
premaster tape with DDP.

device driver The software program that translates commands between the operating 
system and the SCSI Manager. It makes it possible for your system to 
talk to the devices attached to it.

directory, folder A file that contains information (name and location) about the files on a 
disk. Used in almost every storage medium (floppy, hard disk, CD-
ROM).

disc at once A method by which a disc is written. A CD recorder first writes the lead 
in, then the tack data, then the lead out. Link blocks are not inserted. 
Useful for audio-only discs that must be an exact copy of an image. 
Compare track at once.

drive, CD drive The physical components necessary to read data from a CD.
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drive, hard disk A data storage device that employs one or more rigid disks as the 
medium of storage.

DVI Digital Video Interactive. A technology, developed by RCA and sold by 
Intel, that makes it possible to store compressed real-time audio and 
video, then play it back decompressed at the correct speed.

dynamic Marked by continuous change or activity. The data held in dynamic 
RAM cache is swapped out as new data is accessed. It is marked by 
continuous change and activity.

dynamic RAM cache A RAM cache that grabs and holds information as it is read by a 
computer. When full, dynamic RAM swaps out the oldest data with the 
newest data.

ECC/EDC Error Correction Code/Error Detection Code. Information used by the 
drive hardware to detect and correct data errors caused by scratches or 
dirt on a disc. Optimizes data integrity.

CD-ROM uses only 2048 bytes of a sector of 2352 bytes for data storage. 
Header and synchronization information uses 12 and four bytes, 
respectively. The remaining 288 bytes are used for ECC and EDC 
information.

electronic
publishing

Publishing process in which electronic media such as CD-ROM, floppy 
disk, and so on, are used rather than printing on paper.

encryption A complex reordering of information so that it becomes illegible. 
Encryption and decryption are used together. Some of the 
algorithms used are symmetrical, which means that double 
encryption restores the data to its original state.

enhanced CD-ROM Compact discs that combine digital and audio data on a single disc 
in a way that allows trouble-free use of the same disc on both an 
audio CD player and a CD-ROM drive.

extensions The files containing operations required for setting a device to a 
starting state before using data or implementing a process. The old 
name for this is “Inits.”

firmware An often-used microprogram or instruction stored in ROM. Usually 
refers to the ROM-based software that controls a drive.

Form 1 A subformat of Mode 2. Defines the structure of a CD-ROM sector 
as follows: sync (12 bytes); header (4 bytes); subheader (8 bytes); 
data (2048 bytes); EDC (4 bytes); ECC (276 bytes).
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This subformat is used for normal data files including Photo CD and Electronic Book.

Form 2 A subformat of Mode 2. Defines the structure of a CD-ROM sector as follows: sync 
(12 bytes); header (4 bytes); subheader (8 bytes); data (2324 bytes); EDC (4 bytes).

This subformat is used for files where error correction is impossible due to real-time 
characters, that is, compressed audio or moving images.

fragmentation With use over time, the sectors of a file are written in different areas across the storage 
surface. This slows access time because the drive head must move to non-contiguous 
locations to read the contents of a file.

Gb In computing one gigabyte generally equals 1024 x 1024 x 1024 bytes. According to 
ISO standard however one gigabyte equals 1000.000.000 bytes.

Green Book Defines the physical aspects of CD interactive (CD-I). See also standards.

hard disk A permanent storage medium for computer data based on a rotating disk with a 
magnetically sensitive layer. Information can be written on this and read again using a 
read/write head. Information can also be deleted.

HFS Hierarchical File System. Used by Apple for floppy and hard disk and for CD-ROM. 
Apple also supports the ISO-9660 standard.

High Sierra The predecessor of the ISO-9660 standard. Published by the CD-ROM Ad Hoc 
Advisory Committee, also known as the High Sierra Group, on May 28, 1986. Use of 
this standard is no longer recommended. ISO-9660 is preferred.

inits Short for initialization. The operations required for setting a device to a starting state 
before using data or implementing a process. This is the old name for Extensions.

input/output (I/O) The communication flow between a computer and the devices attached to it. 

intelligent Refers to a device capable of processing commands on its own.

interface The go-between that provides a common basis for communication between two 
otherwise incompatible devices.

image A virtual copy of the future CD-ROM disc stored on the hard disk. It is used for writing 
the final premaster tape and/or CD-R disc.

index A separate list of words or keys, sorted alphabetically or numerically along with a 
reference to their location in the text or the data base.

interactive
media

Media with which you interact to find information.

interface The point of contact between two systems. Interfaces can be items of equipment (e.g., 
SCSI interface between computer and CD-ROM player) or software modules (user 
interface).
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ISO-13346 The new ISO standard for optical media based on a file system for write-
once and rewritable media using non-sequential recording.

ISO-9660 The international standard defining the CD-ROM data format. The aims 
of the standard are to achieve interchangeability of discs and to optimize 
performance. It is the official standard to which all CD-ROM 
applications should conform.

JPEG Joint Photographic Experts Group.

Kb In computing one kilobyte generally equals 1024 bytes. According to 
ISO standard however one kilobyte equals 1000 bytes.

Kb/s Kilobytes per second.

LaserVision Video disc system.

latency The time, in milliseconds, it takes for the spinning disk platter to bring 
around the desired sector to where the read/write head can access it. Does 
not include head positioning time. Contributes to access time. (See 
Interleaving.)

mastering The process in which a glass master is produced for production of the 
stampers which are in turn used for replication of the CDs. The glass 
master contains photosensitive lacquer that’s illuminated on a laser beam 
recorder (LBR). The data for mastering comes from a premaster tape.

Mb In computing one megabyte generally equals 1024 x 1024 bytes. 
According to ISO standard however one megabyte equals 
1000.000 bytes.

Mb/s Megabytes per second.

media Another term for the CD platter, but more specifically the surface of 
the platter that holds the data.

megabyte One million bytes (actually 1,048,576).

MMF Multimedia file.

Mode 1 Defines the structure of the CD-ROM sector as follows: sync 
(12bytes); header (4 bytes); data (2084 bytes); reserved (8 bytes); 
ECC (276 bytes); and EDC (4 bytes).
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Mode 2 Defines the structure of the CD-ROM sector as follows: sync (12 bytes); header (4 
bytes); subheader (8 bytes); remainder (2312 bytes) dependent on whether Form 1 or 
Form 2.

mount To appear on the Desktop. To show an icon on-screen.

MouseHelp A form of on-line help in CDT, available only in Setup. Turn MouseHelp on by 
selecting it from the Help menu in the menu bar. Point at something within the Setup 
window you want to know more about, and relevant information appears in a box in 
the lower portion of the application screen.

MPC Multimedia PC with a CD-ROM drive. Defined by Microsoft. An MPC application 
will work on an MPC computer.

MPEG Motion Picture Experts Group. A standard compression method for motion video. The 
ISO standard used by Philips in their CD-I players. The algorithm used (discrete cosine 
transform) makes an extremely high rate of compression possible (200:1). MPEG 
video and audio encoding form the basis for video-CD.

multi-session An ISO standard CD-ROM format often referred to as “Orange book” that allows 
additional information to be added to a writable CD-ROM disc that has already been 
written to once.

multi-volume 
CD-ROM

A CD-ROM with more than one mountable volume on it. In the instance where some 
of the volumes are in formats other than Apple’s HFS, using the Mounting feature in 
CDT will allow you to see the icons of all mountable volumes.

OEM Original Equipment Manufacturer. A company that manufactures a piece of hardware 
or software that is modified or reconfigured by a value-added reseller and sold 
(usually) under the reseller’s brand name.

Orange Book Specifies the physical aspects of CD-recordable media. The first part of the book 
describes CD-MO (magneto optical) system and the second part describes CD-WO 
(write once) system. The CD recorders and CD-R media are all based on the CD-WO 
standard. See also standards.

OSTA Optical Storage Technical Association is a non profit corporation that is promoting the 
use of optical technology, optical drives, media and peripherals.

overhead The incidental command processing time that is necessary to complete a task.

partition A portion of a storage area allocated to a particular use or user.

PCM Pulse Code Modulation. A technique for converting analog audio into CD digital 
audio.

peripheral A device that is attached to the computer, either directly or via the bus.



107

G
lossary

A

physical 
image

The actual bit-to-bit copy of the future CD-ROM disc, without ECC and EDC 
information. Usually a physical image can be as large as 600Mb and will demand a lot 
of hard disk space (all data will be present in the original files and once more in the 
image file).

If an image consists of multiple tracks, a separate image file is created for each track. 
However, GEAR allows you to make an application without the need for so much hard 
disk space by using a virtual image, which is just an administration of the image 
structure.

platter The rigid disk that is used for storing data on hard disk drives.

premaster 
tape

The tape that CD manufacturers use to create the CD-ROM master, which is used to 
make the actual CD-ROMs. The premaster tape is written from the image in the format 
as specified by the CD-ROM manufacturer (possibly in DDP format).

proprietary Vendor-unique technology or devices that are incompatible with other products in the 
industry.

QuickTime An Extension of the Macintosh system software that provides facilities for managing 
time-based data.

read ahead Similar to buffering, except Read Ahead can read ahead to the next expected data. This 
prepares data for the CPU’s next request, speeding up access time.

Red Book A book (with a red binder) that defines the physical aspects of digital audio CDs (CD-
DA). See also Green Book, Orange Book, standards, White Book, and Yellow Book.

replication The process of producing identical copies of a CD-ROM from a stamper or matrix.

retrieval Term for locating information in databases. Retrieval takes place on the basis of 
indexes present.

SCSI ID A device’s unique address on the SCSI bus, referred to as its ID, or identification.

SCSI 
interface

Small Computer Standard Interface. (Pronounced scuzzi.) An industry standard for 
the interface between computers and peripherals.

SCSI manager The SCSI Manager is part of the Macintosh Operating System that provides the 
interface between a program, such as a driver or formatter, and the actual hardware 
SCSI port.

sector A piece of data (a number of bytes) on disc. The size is 2352 bytes. CD-ROM uses 
2048 bytes for data storage. Header and synchronization information uses 12 and 4 
bytes, respectively. The remaining 288 bytes are used for ECC and EDC 
information.

The 2 Kb of data in every sector can be divided into logical blocks of 512, 1024, or 
2048 bytes. Every sector on a CD-ROM disc has a unique address by which it can 
be accessed.
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seek time The time it takes the read/write head to move back and forth in search of the 
appropriate track. Seek time does not include latency or command overhead. (See 
Access Time.)

session One contiguous, spiraling string of data written to, or stamped into, a disc. There may 
be more than one session on a disc. A track is a portion, possibly all, of a session. A 
session may contain many tracks, but a track may not contain a session.

SGML Standardized General Markup Language. An ISO standard that uses tags to add 
structure to information, usually text. Various structural components are indicated 
within the information, e.g., title, subtitles, paragraphs, footnotes, and cross references.

single-session Refers to standard CD-ROM discs where multisession format is not present.

stamping Manufacturing data into a disc (as opposed as writing data to a writable disc).

standards Green Book: The CD-I, CD interactive, standard. Operating system and playback 
hardware specifications for mixed mode CD-ROMs.

Orange Book: Standard for write-once (multisession) CD. A Sony/Philips 
collaboration that details physical and optical characteristics of Compact Disc Write 
Once media, and hybrid ROM/WO discs, which have read-only and write once areas 
on the same disc. This technology is becoming increasingly cost effective. Discs for 
recording use gold as a substrate metal instead of the aluminum employed by mass-
market stamped discs, but may employ both.

Red Book: Standard for normal audio CD. Refers to the specifications for the compact 
audio disc format developed by Philips and Sony. It is the standard format of 
commercial audio CDs. When a disc conforms to the Red Book standard, it will 
usually have “digital audio” printed beneath the disc logo.

In 1983 a consortium of Philips (N.V.) and Sony drafted a comprehensive document 
to thoroughly define the Compact Disc Digital Audio standard. This document, named 
for the color of its cover, describes the physical dimensions, optical characteristics, and 
logical organization, including the table of contents, track, and audio stream formats 
of a compact disc. This is the seminal compact disc document, from which all 
subsequent standards are derived.

White Book: Standard for Video CD. JVC, Matsushita, Sony, and Philips coauthored 
this specification, also known as the “Video CD Standard.” This remains a nascent 
technology, waiting for CD-ROM technology and the right marketing approach.

Yellow Book: Standard for CD-ROM. A standards document that builds on the Red 
Book Standard allowing for the presence of data tracks on a CD. The Yellow Book 
standard specifies that CD-ROM must encode the first track as data. In addition to the 
two layers of error correction outlined in the Red Book, data is further protected by a 
third layer of error detection and correction for added security.
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When a disc conforms to Yellow Book standard, it usually will say “data storage” 
beneath the disc logo.

static Having no motion. Being at rest. The data held in Static RAM cache is the first data 
accessed up to the limit of the cache. It does not change as new information is accessed. 
It has no motion. It is at rest.

subcode Information (time, text, graphical, or MIDI) stored together with audio on a CD and 
spread across eight channels (PQRSTUVW). P and Q contain the time information 
shown on the display of an audio CD player.

thermal recalibra-
tion

The process of recalculating the positions of data on a hard disk platter as those 
positions shift due to the platters expansion under the heat of operation.

track A CD-ROM disc can contain more than one track. Tracks are implemented 
sequentially (like a CD audio disc). If a CD-ROM contains multiple tracks, the data 
part is always stored in the first track and the audio parts (in the case of a mixed mode 
CD-ROM) are stored in the following tracks.

track 1 problem An audio player, when given digital data on track 1, might do a number of things:

• Skip it

• Refuse to play it

• Play silence

• Play the data (sounds like static)

When you attempt to play data on your audio equipment, you are likely to damage your 
speakers

transfer rate The speed at which information can be transferred. Usually expressed in terms of 
Kb per second. A standard CD-ROM drive is rated at 150Kb/second. A double 
speed player can handle 300Kb/second.

UDF The Optical Storage Technology Association (OSTA) has defined the Universal 
Disk Format (UDF) as a subset of ISO13346 in order to maximize data interchange, 
creating a flexible format that is eminently suited for incremental write (see below). 
Although UDF is not an official standard, it has since become a de-facto standard 
for the industry.

unicode Coding of character sets making use of 2 bytes. ASCII is a subset of unicode.

virtual
image

Making a CD-ROM image usually requires an exceptional amount of hard disk 
space; all data is present in the original files and duplicated in the CD-ROM image. 
GEAR lets you make an application, without the need for so much hard disk space 
by producing a virtual image that is just an administration of the image structure.

The software keeps a record of the files to be included in the final application. 
Simulation and writing of the final premaster tape or CD-R is done using this 
volume administration, thereby eliminating the need for a lot of expensive hard disk 
capacity.
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A CD-ROM can contain multiple tracks in which case multiple virtual tracks are 
created; an administration is kept for every track of the CD-ROM.

virtual track See virtual image.

volume The CD-ROM term for a complete CD-ROM disc. In case of very large databases, 
multiple discs can be issued forming a volume set. When a mixed-mode disc is made, 
a volume will contain multiple tracks.

VTOC Volume Table of Contents. This is the portion of the CD-ROM disc that contains basic 
information about the disc, such as its name, copyright information, pointers to various 
blocks of data, whether the disc is a member of a multi-volume set, dates, version, 
numbers, etc.

White Book Specifies the physical aspects of video CDs. See also standards.

Yellow Book Defines the physical aspects of CD-ROM. A special extension of this book describes 
CD-ROM XA (compact disc extended architecture). See also standards.
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GEAR Commands

You can insert GEAR commands in batch files or you can use them as a single 
command line. When you use commands, you must enter them as follows:

command_name <y | n> <parameter> [optional]

A parameter that’s enclosed in angular brackets (< and >) is a required parameter. 
A parameter that’s enclosed in square brackets ([ and ]) is an optional parameter. A 
bar (|) between two parameters indicates that a selection between two or more 
parameters has to be made.

Special keys, such as Escape and Carriage Return, are abbreviated and enclosed in 
angular brackets—<ESC>, <RETURN>.

When you don’t specify a parameter, GEAR prompts you for the missing 
parameter. The default value is displayed between brackets. You can select it 
by pressing <ENTER>.

The same holds true when extra information is required. You can interrupt a 
command by pressing <ESC>. GEAR may take a short time to stop executing 
the command because commands must release system resources they’re no 
longer using.
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Using GEAR Commands in Windows

General commands

BATCH <file_name>

The name of a batch file, a full path is allowed.

Starts executing a text file with GEAR commands or a previously created log file. The 
complete session stored in the log file is repeated including the question dialogs When 
you run a batch file, lines that begin with a semicolon or an unknown command will be 
ignored. If there are lines that have invalid or missing parameters, the software prompts 
you to provide the parameter.

Note: It is not possible to run the batch command from within another batch file!

LOG [<file_name>]

The name of the log file, a full path is allowed.

In combination with a filename this command starts the logging of commands in the 
specified file. If logging has already been started LOG stops logging. If logging is 
stopped and later on restarted again with the same file name (without leaving the 
application) then the log information will be appended to this file, otherwise the 
existing file will be renamed. It is not possible to start the logging of commands twice 
without stopping the logging in between. 

All session (= the process of creating a disc) information will be stored in the file, that 
is commands and results of commands. All results will be preceded by a semi-colon in 
the log file.

To summarize, use:

LOG <file_name> to start logging, if not yet active.

LOG to stop logging, if already active.

SCANCDR

Scans for CD-Recorder devices on all target/SCSI ID's on all SCSI and/or IDE busses/
adapters, using the currently selected driver interface. The output information will be 
logged with the logging functions. 
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SCANDISK

Scans for hard drives on all target/SCSI ID's on all SCSI and/or IDE busses/adapters, 
using the currently selected driver interface. The output information will be logged with 
the logging functions.

SCANJUKE

Scans for medium changer (Jukebox) on all target/SCSI ID's on all SCSI and/or IDE 
busses/adapters, using the currently selected driver interface. The output information 
will be logged with the logging functions. 

SCANTAPE

Scans for (premaster) tape units on all target/SCSI ID's on all SCSI and/or IDE busses/
adapters, using the currently selected driver interface. The output information will be 
logged with the logging functions. 

VDIR

An overview of all volumes in the working directory contains the following:

• Volume name and size

• Session number

• Number of tracks in the volume

• Type of volume

• Status of volume

• Date and time stamp for the volume

The status of a volume can be either Selected or Closed. A volume is selected if it’s 
currently selected by a OPENVOL or SESSION command. Otherwise, the status of a 
volume is closed. The date and time stamp of the volume is determined using the 
time zone (TZ) environment variable. If you don’t specify this variable, the data and 
time is shown for the Pacific time zone. 

CD <dir_name>

Directory name in the virtual image.

Changes to the specified directory in the virtual image. The command recognizes 
commands like CD.., CD \, CD SUB1, and CD \SUB1. It is possible to specify a path 
name as the directory name.
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COPY <file_name>

Name of a file, wildcards are allowed.

Copies the specified data file(s) into the current directory of the selected track of the 
virtual image. Depending on the value of the generator parameter, see the 
NonIsoHandling attribute the GEAR.INI file, the software will replace any invalid 
characters in the file name automatically, will prompt the user to change the file name, 
or leave it unchanged (non ISO). The file(s) will be copied to the first free space large 
enough to contain the file(s). It is possible to specify the exact location (sector number) 
for the file(s). This can be achieved by the SpecifyStartSector option. The software will 
ask for the start location of each file to load. Files can also be made hidden by setting the 
MakeAllHidden parameter to TRUE before copying the files. The hidden attribute 
cannot be changed afterwards otherwise than deleting the corresponding files and 
reloading them.

When you want to copy audio files you must select an audio track in the volume. Each 
file that is copied into the audio track will then be interpreted as a raw audio file. These 
files must always fulfill the requirements specified in the Red Book. That is, the audio 
file is expected to contain 16 bits PCM audio samples, stereo with a sampling frequency 
of 44.1 kHz. Furthermore, the byte order must be the same as the byte order used by 
your computer. If this not the case, you can change the MSBAudio field in the GEAR.INI 
file. For audio files created on a Windows platform this field should be FALSE, whereas 
TRUE is expected on a MAC.

Depending on the audio package you’re using, the audio file may contain sound 
headers. If sound headers are not removed or cleared, they will cause a sharp click in the 
resulting audio track. For WAVE, AIFF and Sound Designer II audio files meeting the 
previous specifications, the header is automatically removed when you copy these files 
to an audio track and as a consequence no clicks in the audio tracks will occur. 
Nevertheless, in order to remove sound headers properly, these headers must be at the 
beginning of an audio file. Headers in the middle or at the end of a file are not skipped. 
Sound Designer II is a MAC-specific format in which only the data fork (Red Book 
compliant) will be written. The resource fork containing the sound header will not be 
written to CD.

Note: You should never copy temporary files, swap files or the software’s administration files 
into your image. These files are updated continuously and will therefore cause problems while 
verifying your image. Likewise, we advise to never copy any file from the working directory since 
all administration files are created in the working directory. Damaging or deleting an 
administration file will make the volume useless.



Using GEAR Commands in Windows 115

C
om

m
ands in W

indow
s 95

B

COPYMMF <file_spec> <mm_type> <ch_nr> <int_fac> <tot_fac> 
[<EOR|TRG>]

Copies the multimedia files you specify to a virtual XA track. Interleaving is 
performed by the software Usually it is easier to use the dedicated CD-ROM XA 
interleaver tools for creating these files and use the COPYXA command to load 
pre-interleaved multimedia files.

COPYTREE <source_dir> [<target_dir>]

Copies a complete directory tree into the specified directory of a selected track (ISO 
or XA) in the virtual image or into the current directory when the target directory is 
not supplied. All files and subdirectories of the specified tree are automatically 
loaded, subdirectories are created in the image if necessary. After completion the 
virtual image contains an exact copy of the specified tree. The software will create as 
many space as necessary for each directory in the specified tree.

file_spec Full path to the file to be copied into the image.

mm_type for audio <ADPCM><A|B|C><S|M><N|E>
E.g. ADPCMBSN means ADPCM audio, level B stereo, no 

emphasis.

mm_type for video: VIDEO2048
This is used if each sector contains video data and EDC/ECC 

codes.

mm_type for data: DATA2048

ch_nr Channel number for file. Ranging from 0-31.

int_fac Interleave factor for file, ranging from 1-16.

tot_fac Total interleave factor, ranging from 1-16. This number 
together with int_fac determines the interleaving of each file.

EOR End of record bit should be set in the subheader of the last sec-
tor of each file that is loaded. Can be specified together with 

TRG.

TRG Specifies whether the trigger bit should be set in the subheader 
of the last sector of each file that is loaded. Can be specified 

together with EOR.

source_dir The source directory to be copied.

target_dir The target directory specifies where the directory will be loaded 
in the virtual image, it cannot contain a path. If it does not exist 
in the virtual image COPYTREE will automatically create the 

directory in the image.
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Example Suppose you have a track selected containing two directories: DIR1 and DIR2. Issuing

COPYTREE C:\\HOME DIR2

results in a question whether you would like to merge the DIR2 and HOME directory 
into DIR2.

COPYXA <file_spec>

Pre-interleaved XA file(s), wildcards are allowed.

Copies the specified pre-interleaved multi media XA file(s) into the virtual XA track. It 
is assumed the specified files are pre-interleaved XA files (the so called XA streams). 
Pre-interleaved XA files are files which already contain the XA specific subheader. 
Therefore the size of such a file should always be a multiple of 2336 bytes. It is the users 
responsibility to use this command only for pre-interleaved files. 

DELDIR <dir_name>

Existing directory name in a virtual image, wildcards are not allowed.

Deletes the specified directory from the selected track in the current volume. The 
directory must be empty, otherwise it cannot be deleted. Use the DELTREE command 
to remove complete directories from the virtual image.

DELETE <file_name>

File name in a virtual image. Files have to be specified by their complete names, 
including the version number. Wildcards (* and ? ) are allowed.

Deletes the specified file(s) from the virtual image. For example, DELETE *.*;* 
will delete all files in the current directory of the virtual image. If files with non-
ISO names have been loaded, you can omit the version number. TRUE is returned 
whenever the specified files can be deleted, else FALSE.

DELTREE <dir_name>

Directory tree, wildcards are not allowed.

Deletes the specified ISO tree from the virtual image. The specified directory and all its 
subdirectories are deleted.

DELTRK <track_nr>

Track number.
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Deletes the specified virtual track in the selected volume. All administration files and 
the physical image file, if present, are deleted as well. Note that deleted tracks cannot be 
restored.

DELVOL <volume_name>

The name of the volume that will be deleted.

Deletes the specified volume and all tracks in it. In addition, all administration files of 
the volume and its tracks are deleted and the physical image file if present. Be sure you 
want to do this because inadvertently deleted volumes cannot be restored.

NEWDIR <dir_name>

Name of a directory.

Creates a new directory in the selected track of the current volume. The directory name 
should be different from the existing directories in the selected track. If possible the 
number of files and directories in a directory should be restricted to about 50, what will 
improve the performance of the future CD-ROM.

NEWTRK <track_type> [<track_nr>]

Creates a new empty virtual track with the given type in the selected volume. The 
track is automatically selected and its size will be expanded to take the remaining 
space within the volume. Optionally a track number can be specified, which is only 
relevant to insert DA tracks since ISO and XA tracks always have track number 1. 
Tracks with a number exceeding the inserted track number are moved up. 
Consequently, it is not possible to have ISO and XA tracks in one and the same 
volume or to create volumes with a DA track in front of an ISO or XA track. Besides 
these constraints, the number of tracks in an image is limited to 99. Furthermore, it 
is not possible to have other tracks in the image than a UDF track.

track_type The track type ISO, XA, DA or ISO/UDF.
ISO is referred to as mode 1 format for the storage of computer 

data according to ISO 9660. 
XA (eXtended Architecture) is a track type for computer data 

extended with extra multi-media possibilities.
DA is a track type for digital audio (Red Book).

ISO/UDF is a hybrid mode 1 track.

track_nr Track number between 1 and the number of tracks in the vol-
ume.
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The administration files of the virtual track are created in the current directory. The 
names of all the administration files consist of the volume name followed by the 
extensions '.mxx', '.ixx', '.fxx' and ‘.vxx’, where xx stands for the track number. In case 
a ISO/UDF track is made the temporarily output files .udf and .lvid are made.

Note: You should never edit, delete or otherwise modify the administration files 
manually. This will result in a corrupted and thus useless image.

NEWVOL <volume_name> <capacity>

Creates a new empty virtual volume with the name and capacity in minutes you specify. 
The new volume is selected automatically. The volume administration file will be 
placed in the current directory and its name is the volume name followed by the .vol 
extension. This name will not change even if extend the volume identifier.

Note: You should never edit, delete or otherwise change the administration files by yourself. 
This will result in a corrupted and thus useless image.

OPENVOL <volume_name>

The name of an existing volume.

volume_name The name of the volume to be created. The 
following restrictions can be applied to the volume 
name: ISONameHandling, ISO 9660 PVD and OS 
filenaming restrictions.

capacity Indicates the length in minutes of the CD image. Not 
all sizes are applicable to all media, see the 
following table for an overview of formats.

Image size CD-R DVD-R DVD-T

18 min. 158 MB x x x

63 min. 553 MB x x x

74 min. 650 MB x x x

80 min. 703 MB x x x

428 min 3.95 GB x x

509 min 4.7 GB x x
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As explained before, VDIR displays an overview of all volumes. If you want to edit one 
of these volume’s contents it must be selected. To this end, OPENVOL opens a volume 
and the previously selected volume (if any) is closed. Consequently, there can only be 
one volume opened simultaneously. 

PHYSTRK [<file_name>]

Optional physical file name, may include a full path.

Assuming you have selected a volume and a track, PHYSTRK creates a physical image 
file of this track. The physical image file is a byte for byte copy of the future CD-ROM 
track. The sector sizes for the tracks are based on their type as follows:

Before writing the image file the software will verify the files loaded in the virtual track. 
For each file in the track the time, date and size of loading is checked against the current 
time, date and size of the file. If any file is not up to date, i.e. the check fails the physical 
image is not written. The image can be updated by deleting the reported files from 
the virtual image. It is not strictly necessary to write a physical image file, all 
modules can handle virtual images as well as physical image files.

The physical image contains the contents of the virtual image at that point in time. 
Any subsequent changes in the volume will only affect the virtual image. However, 
the physical image will be marked out of date. The default physical image file name 
is the name of the volume with the Pxx extension where xx stands for the track 
number. This default physical image file is normally written in the current directory. 
However, if the optional parameter file_name is specified the image will not be 
written as the default name in the current directory but as file_name on the specified 
location.

PHYSVOL [<file_name>]

Optional physical file name that may include a full path.

Creates the physical image files of the selected volume. For each track in the image 
a physical image file is created. Each physical image file is a byte for byte copy of the 
future CD-ROM track. Before writing the image files the software will verify the 
volume. That is for each file in each track in the virtual image the time, date and size 

 Track type Sector size

ISO/UDF 2048 bytes

ISO 2048 bytes

XA 2336 bytes

DA 2352 bytes
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at loading is checked against the current time, date and size of the file. If any file is not 
up to date (i.e. the check fails) the physical image file is not written. The image can be 
updated by deleting the reported files from the virtual image. It is not strictly necessary 
to write a physical image file, all modules can handle a virtual image as well as a 
physical image file. If, however the transfer rate for recording has to be increased you 
should use a physical image for writing to CD-R. Otherwise, you can usually write with 
a virtual image.

The physical image contains the contents of the virtual image at that point in time. Any 
subsequent changes in the volume will only affect the virtual image. The default 
physical image file names are <volume name>.Pxx where xx stands for the track 
number. These default physical image file are normally written in the current directory. 
However, if the optional parameter file_name is specified the images will not be written 
as the default names in the current directory but as file_name on the specified location. 
The file_name argument should therefore be specified preferably without an extension 
as volumes having more tracks will overwrite the previous ones.

RENAME <old_name> <new_name>

Renames a directory or file in the virtual image to the desired name, relative to the 
current directory. E.g. to rename a nested directory X:\Y in your image to, e.g. S, you 
should first change to directory Y and then rename this to S (RENAME Y S).

Note: The administration will store the original filename as well, so the VERVOL or VERTRK 
command will not report an error during volume or track verification.

SELTRK <track_nr>

Track number between 1 and the number of tracks in the volume.

Selects an existing track in a selected volume, the previously selected track if any is 
minimized and closed. A volume and track must be selected before you can edit the 
contents of a track. 

old_na
me

File or directory name in the virtual volume.

new_n
ame

New file or directory name. Path specification is not supported.
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VERTRK

Verifies the contents of the virtual image of the selected track and checks if a physical 
track image can be created. For each file in the virtual image the time and date of 
loading is checked against the current time and date of the file. The files that are not up 
to date are reported. The image can be updated by deleting the reported files from the 
virtual image.

VERVOL

Verifies the contents of all virtual tracks in the selected volume and checks if physical 
(track or volume) images can be created. To this end, for each file in each track in the 
virtual image, the size, date and time stamp at loading is checked against the current 
size, date and time of the file. The files that are not up to date are reported. If there are 
discrepancies, it usually means a file has been modified since it was loaded into the 
volume. The image can be updated by deleting the reported files from the virtual image.

DISCINFO

Obtains track and session information of the disc currently loaded in the selected 
recorder. 

Example The total disc space in megabytes for an ISO disc can be calculated from the lead-out 
address (Logical Block Number, LBN) as follows:

Total disc space = (lead out address) * 2048 / (1024 * 1024)

The free space on the disc in megabytes is calculated from the lead-out address 
(LBN) and first writable address (LBN) as follows:

Free space on disc = (lead out address - first writable address) * 2048 / (1024 
* 1024)

EJECT

Ejects the CD -R(W) disc

RETRACT

Retracts the CD -R(W) disc in case of a tray device. This command cannot work for 
a caddy device.

ERASECD

Erases a complete CD -RW disc
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ESTIMATE [ <name> [X] [<type>] ]

This command estimates if the system performance is sufficient to write the specified or 
currently selected volume to a CD-R disc. No data is transferred to the recorder during 
this process. If parts of the image cannot be read fast enough, the software warns you. 
Depending on the current value of the Use Physical Image in the GEAR.INI file, the 
virtual volume or the physical image file is used during this process. An optional letter 
X after the name can be used for estimating if the given external physical image file or 
track list file can be written to CD-R disc. The command can be used to estimate the 
performance of the specified or selected volume, external file or track list file.

Note: This software estimate involves only reading the image data. Another drawback is that 
it doesn’t take the SCSI hardware performance into consideration. While estimating your 
system’s performance is a reliable method, test-mode recording is more accurate, see the 
explanation of the WRITECD command.

Any of the following options can be used to optimize your system’s performance:

• Close any other software applications you’re running in the background.

• Use a defragmentation utility to defragment your hard disc.

• Check to see whether your hard drive does recalibration. If so, disable it or choose 
a working directory on a non recalibration drive.

• Check to see if your SCSI termination is correct. An incorrect SCSI termination 
can cause delays on the SCSI bus.

• Check to see if there is enough free memory.

• Use a physical volume instead of a virtual image.

• Use a lower recording speed if one is available.

• Use cyclic buffering as the CD-R interface (only Windows 95/NT).

name Name of a volume, external image or (text) track list file.

X Indicates that the name argument should be interpreted as an 
external image or track list file.

type External image type (see WRITECD).
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FIXATION

Writes the lead-in and lead-out to a CD-R disc that is not yet ‘fixated’. This can be 
useful if the recording of a disc failed due to, for example, a buffer underrun. To 
overcome an erroneous situation, issuing the FIXATION command followed by 
SESSION 0 may result in a still usable disc, thought the previous information will be 
lost irreversibly. Normally, the WRITECD command writes the lead-in and lead-out 
automatically if the fixation setting is turned on.

READCD <track_list_file_spec> [<output_dir_spec>] [TAO | DAO]

READCD reads all tracks of a single session CD onto the hard drive. 

Note: Use READCD <track_list_file_spec> [<output_dir_spec>] [TAO | DAO] to read all 
tracks of a single session CD and to write the output to a text track list file.

All nonaudio tracks will be read into separate image files, whereas audio tracks 
will be gathered into one image file. The output files and the ensuing text track list 
file will be placed in the current working directory or the directory location 
specified by their respective command arguments. The output files will be 
described by the word ‘IMAGE’ concatenated with ‘M1’ for mode 1, ‘DA’ for 
digital audio, ‘CDI’ for CDI or ‘XA’ for XA tracks. The extension of these files will 
consist of two-digit number ranging from 01 to a maximum of 99 to indicate the track 
number on CD. For instance suppose that a disk contains one mode 1 track followed 
by three audio tracks. READCD will then produce a ‘IMAGEM1.01’ and 
‘IMAGEDA.02’ file. Furthermore, the DAO or TAO option can be specified to 
accommodate the track list especially for DAO or TAO recording. If necessary, track 
sizes etc. will be adjusted to force a more perfect copy with the given write method 
that will be used for writing the track list. 

The (binary or text) track list file can subsequently be used with the WRITECD 
command option to write track list files.

track_list_file_spec Track list text file that will be created containing all the entries 
for the track image files. The function expects an existing direc-

tory if the track list specification includes a full path.

output_dir_spec Name of an existing output directory where the track images 
will be stored (default is the toolkit’s working directory).

TAO | DAO Track-at-once reading (TAO) or disc-at-once reading (DAO). 
Default value is DAO or TAO for non disc-at-once recorders.
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READFILE <source_file> [<dest_file>]

Command READFILE is used to read the contents of a file present on CD-R:

Note: Use READFILE <source_file> <dest_file>, to read a complete file (source_file) from 

CD-R and to copy this file to a destination (dest_file) on the hard disk. The actual reading of this 

destination file must be performed by the user.

READTRACK <track_nr> <file_name> [ MSB | LSB | WAVE ]

In general, this command reads all sectors of the specified track from the CD-R disc 
then saves them in the specified file. In addition, there is the option to augment Red 
Book audio file with a wave header (WAVE). The amount of information read depends 
on the track type. READTRACK will automatically determine the track type, size, and 
start position, then start copying. For ISO tracks (mode 1), 2048 bytes are read per 
sector, for CD-ROM XA and CD-I (mode 2), 2336 bytes are read per sector and for CD 
digital audio, 2352 bytes are read per sector. Not all CD recorders support the reading 
of CD digital audio and/or CD-I tracks. 

Note: Use READTRACK <track_nr> <file_name> [ MSB | LSB | WAVE], to read all sectors 

of the The track image file - or a list of recorded track image files collected in a track list can be 

written to a CD-R again utilizing the WRITECD command.

source_file The filename (without path) in the current directory of the vol-
ume created with the SESSION command.

dest_file The destination file (including path name) on the hard disk.

track_nr Specifies the track number on the CD.

file_name The name of the physical image that will be created on the hard 
drive. The function expects an existing directory if the image 

name includes a full path.

MSB | LSB | WAVE This option is applicable to Red Book audio files only. The 
MSB or LSB option indicates the byte order of the target sys-

tem. For example, Intel based PCs should use LSB, and Macin-
toshes MSB. The default value will be the byte order for the 

target system for which the software is compiled. If the WAVE 
option is used, the READTRACK command should produce a 

WAVE file directly instead of a Red Book file. That is, a 
44.1KHz 16 bit audio file with the wave header of 44 bytes long 
at the beginning of the file correctly filled in. The audio type in 

the WAVE file must be of type LSB.
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RECORDERINFO

Retrieves information about the capabilities of the recorder, i.e., the Vendor/Product/
Revision information of the current CD recorder, and its supported features. 

SESSION [<session_nr>] [<track_nr>] [<track_type>] [<volume_name>]

The session command is used to append data to a multi session disc. Both the generator 
and the CDR engine must be initialized prior to executing this command. When you use 
the session command a new volume is created, based on the information of one of the 
previous sessions on the CD-R disc. To this a session and track number must be 
supplied (default the first track in the last session on the disc). The selected session on 
the CD-R is read and a volume is created which contains the complete directory/file 
structure of this session. After the volume is created, you can add or remove data just 
like with any other volume. The new session can be appended to the CD-R by using the 
WRITECD command.

If you append to an audio track you must also supply a volume name and track type, 
previous volume information will not be accessible anymore. A session command with 
a 0 as argument (SESSION 0) forces to create a new volume and makes the previous 
sessions on CD inaccessible.

WRITECD [ <name > [<nr_copies>] [X] [<type>] ]

Writes the given volume to a CD-R disc. In case no arguments are supplied the 
currently selected volume is written. Depending on some parameters the virtual 
volume or the physical image file is used (regulated by the Use Physical Image in the 
GEAR.INI file. An optional letter X after the name parameter can be used for writing 
an external physical image file or track list file to a CD-R disc. The current setup 
values are used except the Use Physical option. The given file is interpreted as a 
physical CD-ROM image file or as a track list file.

name Name of a volume, external image or (text) track list file.

nr_copies Number of copies to write, default is one.

X Indicates that the name argument should be interpreted as an 
external image or track list file.

type External image type.
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The WRITECD command always creates a wo_ident.txt and woresult.txt file 
containing some status information and customer information that’s written to the CD 
recorder. You can use the number of copies parameter to write multiple discs of the 
same volume. If a medium changer is connected to the same SCSI bus as the CD 
recorder, the medium changer is used to change the discs. otherwise, you are prompted 
to perform the medium change.

If the CD recorder supports a test mode or write disable mode, you can set WriteEnable 
to FALSE, which will give you a more accurate estimate than issuing the ESTIMATE 
command. In this case, all data is transferred to the CD recorder’s buffer but the disc 
isn’t actually written. Therefore, you can check system performance without recording 
a disc. Test-mode recording takes the actual time that recording takes even though 
you’re not actually recording a disc.

We distinguish the following predefined external physical image types (type):

1 CD-ROM mode 1 (ISO etc.) sector size 2048 (default). Used for a standard ISO image 
file, HFS image or CDTV image.

2 CD-ROM mode 1 (ISO etc.) sector size 2352. Used for a standard ISO image file which 
contains EDC/ECC codes.

3 CD-ROM mode 1 (ISO etc.) sector size 2352, scrambled sectors with 2 seconds pregap. 
Used for an ISO image file which contains EDC/ECC, a pregap and is scrambled.

4 CD-ROM XA mode 2 sector size 2336. Used for a standard XA image file or EB XA 
image file (e.g. images with Mammoth XA files).

5 CD-ROM XA mode 2 sector size 2352. Used for a standard XA image file which con-
tains EDC/ECC codes.

6 CD-ROM XA mode 2 sector size 2352 scrambled sectors with 2 seconds pregap. Used 
for an XA image file which contains EDC/ECC, a pregap and is scrambled.

7 CD-I mode 2 sector size 2336. Used for a standard CD-I image file without EDC/ECC.

8 CD-I mode 2 sector size 2352. Used for a standard CD-I image file which contains 
EDC/ECC.

9 CD-I mode 2 sector size 2352 with 2 seconds pregap. Used for a standard CD-I image 
file which contains also a pregap.

10 CD-I mode 2 sector size 2352 scrambled sectors with 2 seconds pregap. Used for a CDI 
image file which contains EDC/ECC, a pregap and is scrambled.
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The track list file is a plain text file in which each line represents a complete CD track. 
The syntax of a line can be defined either by using any of the above predefined image 
types:

<track_image_filename> /<predefined_image_type>

Or a line in a track list can be defined using ‘user-defined’ track image types:

<track_image_file_name> <track_type> [<sector_size>] [+P:<pause>] 
[O:<offset>] [L:<length>]

11 Standard DA, frame size 2352. Used for a standard audio file without any headers, the 
file should contain 16 bits stereo samples while the byte order of the audio file must be 
the byte order used by the computer running the toolkit software. Note that the size of 
the pregap should always be 2 seconds (150 sectors). Scrambled images must contain 
SYNC, HEADER and ECC/EDC information. Unscrambled images can be accepted 

with a 2352 sector size without the SYNC, HEADER and ECC/EDC filled in. In addi-
tion there is the possibility to write a track list file to CD by using the following external 

image type 12.

12 Use file <name> as a track list file. Used to specify more than one track in a so called 
track list file.

track_image_filename A full specification of an existing track image file on your com-
puter, e.g. something like C/MUSIC/AUDIO.TLF.

predefined_image_type One of the predefined image types (preceded by the ‘/’ sign).

track_type A type string identifying the type of track. Possible options are 
‘MODE1’, ‘XA’, ‘CDI’, DA’.

sector_size The sector size (bytes per CD sector) of the track image file. Possi-
ble values are ‘2048’, 2336’, 2340’, 2352’, 2352S’. ‘2352S’ means 
the data in the track image are scrambled. Default values are 2048 

for MODE1 tracks, 2336 for XA/CDI tracks and 2352 for DA 
tracks.

pause The size of the pause/pregap (index 0) of a track in sectors/frames 
(75 frames is 1 second). A ‘-‘ sign before P means that the pause is 

not included in the image file, and that the pause is added as 
silence by the software to the (beginning of) a track. A ‘+’ sign 

before P indicates that the pause is included in the image file, and 
that data from the beginning of the image file are used for the 

pause. Furthermore, the following observations should be taken 
into account:

0 (zero) is an allowed value for the pause.
The default value is 150 frames not included 

(-P:150).
The first track can only have the value of 150 - 225.

Non-default pause sizes are only supported with disc-at-once 
recording.
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Note: Offset and length can be used if the start and the end of a track do not match with the 
start and the end of a file. An image file containing multiple tracks can be used by specifying the 
same file name on every line in the track list file, and using appropriate values for offset and 
length on every line.

Example To write a mixed-mode image - one that contains mode 1 or mode 2 data - and using any 
of the predefined image types, you can specify the following lines in a track list file, say 
EXAMPLE.TLF:

/IMAGE.DAT /1

/AUDIO.2 /11

/MUSIC/AUDIO.3 /11 {No return after last line.}

||

track path name image type number

The following few lines is an example of a track list file (EXAMPLE.TLF) with user-
defined track types:

/MYIMAGE/DISCTRAX.001 DA

/MYIMAGE/DISCTRAX.002 DA  -P:0

/MYIMAGE/DISCTRAX.003 DA -P:300

/MYIMAGE/DISCTRAX.004 DA +P:150 L:1000

/MYIMAGE/DISCTRAX.004 DA -P:0 O:1000

{No return after last line.}

Jukebox commands

JUKEINFO

Retrieves information about the connected jukebox. The arrays indicate if a specified 
address contains a disk or not.

offset The offset in frames where the track should start within an image 
file. The default value is 0.

length The length in frames of the track (within an image file). The 
default value is the complete file length.
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MOVEMEDIUM <src_address> <dest_address>

Moves a caddy/disc from one location (address) to another in the jukebox. Predefined 
location ranges are specified for storage slots, drives, mailbox, and gripper(s). Storage 
slots are numbered from location 1 to 1000. Drivers (CD recorders and CD readers) are 
numbered from location 1001 to 2000. the mailbox of the jukebox has location number 
2001. The grippers - the device that actually moves the medium - are numbered 3001 
and 3002.

Tape commands

VERIFYTP [ <name> [X] [<type>] ]

Verifies the volume with a premaster tape.

Note: Use VERIFYTP, to verify the specified or selected volume, external file or contents 
of a track list file to a tape.

WRITETP [ <name> [X] [<type>] ]

Writes the volume to premaster tape.

Note: Use WRITETP to write the specified or selected volume, external file or contents of 
a track list file to a tape.

src_address Original location of caddy/disc.

dest_address New location of caddy/disc.

name Name of a volume, external image or (text) track list file.

X Indicates that the name argument should be interpreted as an 
external image or track list file.

type External image type.

name Name of a volume, external image or (text) track list file.

X Indicates that the name argument should be interpreted as an 
external image or track list file.

type External image type (see WRITECD).
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The gear.ini and Preferences File

Windows initialization file
The gear.ini file contains information used by GEAR. You can edit the gear.ini file 
with any text editor. It’s a good idea—before you begin to edit the file—to make a 
backup copy of it with a different name.

During startup, GEAR tries to locate the gear.ini file in the current working 
directory. If the file is not in the current working directory, the GEARDIR 
environment variable is used to locate it. Without the information in gear.ini, 
GEAR cannot run properly and will notify you if it cannot find the gear.ini file.

You can change the information in the gear.ini file with a standard text editor 
like Windows Notepad, however, we recommend you use the commands 
available in the GEAR menus.

As you look at the gear.ini file, keep in mind the following points:

• Lines that start with a semicolon are treated as comments—information 
that doesn’t affect how GEAR performs.

• You must enter parameters immediately after the = sign; parameters are 
interpreted beginning with the first character that follows the = sign.

• All parameters are case sensitive.

Below you find the gear.ini file followed by a detailed explanation.

The gear.ini file
; GEAR.INI file
;
;
[generic]
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;

WorkingDirectory=C:\GEARIMG95

DefaultDiscSize=74

DefaultTrackType=ISO

MSBAudio=FALSE

;

; Customer information:

CustomerName=

CustomerContact=

CustomerPhone=

MasterIDCode=

ReferenceCode=

UPCEANCode=

DiscTitle=

;

;

[generator]

;

SystemIdf=GEAR 

PublisherIdf=

DataPreparerIdf=ELEKTROSON

ApplicationIdf=

ApplicationUse=

CopyRightFileIdf=

AbstractFileIdf=

BibliographicFileIdf=

MaxNrDirsInVolume=2048

MaxDirNestingLevel=12

; 'NonIsoNameHandling' determines how the software handles non-IS09660 names.

;   Possible values are:

;   0) Dialog appears for each non-ISO9660 name

;   1) Do not translate non-ISO9660 names

;   2) Translate non-ISO9660 names to upper case only

;   3) Translate non-ISO9660 names completely

;   4) Translate non-ISO9660 names completely to DOS compliant names (8+3)

NonIsoNameHandling=1

ArchiveOnly=FALSE

ArchiveReset=FALSE

LoadHiddenFiles=TRUE

LoadSystemFiles=TRUE

;
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[cdrecording]
;
; Parameters for CD-Recording:
UsePhysicalImageFiles=FALSE
VerifyImage=TRUE
EstimateBeforeWrite=FALSE
WriteEnable=FALSE
; 'WriteMethod' determines how the CD-R disc is written.
;   Possible values are:
;   1) Disc at once recording (write lead in->tracks->lead out: no link areas).
;   2) Track at once recording (first write tracks, then fixate).
;   3) Fixed packet recording (first write tracks/packets, then fixate).
WriteMethod=2
NrOfWriters=1
ReadSpeed=4
WriteSpeed=2
Fixation=TRUE
MultiSession=TRUE
VerifyAfterWrite=TRUE
; 'CDRInterface' determines which type of CD-R driver is used.
; Please check the 'BufferSize' setting if you change the 'CDRInterface' setting.
;   0) Null device
;   1) WinAspi32.DLL with double buffering
;   2) WinAspi32.DLL with cyclic buffering
;   3) Windows NT native Miniport SCSI driver
CDRInterface=2
; Host adapter number (0-3) to use:
HostAdapterNumber=1
; 'BufferSize' determines the size of the SCSI buffer(s) allocated by GEAR.
; The setting must be between 32768 (32 KB) and 65280 (almost 64 KB).
; Recommended size for cyclic buffering (CDRInterface 2): 32768.
: Recommended size for CDRInterface 1, and 3: 65280.
BufferSize=32768
; 'DoubleBuffering' determines if a double buffering strategy is used by GEAR.
; Has to be set to FALSE if same SCSI card is used for the CD recorder and
; system hard drive (with data files). Only valid for CDRInterface 1.
DoubleBuffering=TRUE
; 'NrOfCyclicBuffers' determines the number of cyclic buffers allocated by GEAR.
; Only valid for CDRInterface 2. The minimum setting is 16.
NrOfCyclicBuffers=96
; SCSI ID of CD-R unit (only relevant in case of multiple units):
TargetID=5
; Settings for medium changer device (jukebox):
UseMediumChanger=FALSE
InitializeMediumChanger=FALSE
DriveNrInMediumChanger=3
FirstSlotNumber=1
NrOfSlotsInitialized=10
;
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[tape]

;

; Parameters for premaster tape output:

; 'DDPFormatTape' determines whether DDP files are (also) written to the tape.

DDPFormatTape=TRUE

; 'FileOption' determines how tracks are written in tape files

;   Possible values are:

;   1) Separate files on separate tapes for each track

;   2) Separate files for each track on the same tape

;   3) Tracks of the same type are combined in one tape file

;   4) One contiguous image tape file including all tracks

FileOption=2

ISOTrackSectorSize=2048

ISOTrackBlockingFactor=4

ISOTrackWithPregapPostgap=FALSE

XATrackSectorSize=2336

XATrackBlockingFactor=4

XATrackWithPregapPostgap=FALSE

DATrackWithPause=FALSE

ScramblingFor2352Sectors=FALSE

WriteIdentTxtOnTape=FALSE

UsePhysicalImageFiles=FALSE

VerifyAfterWrite=FALSE

; 'TapeInterface' determines which type of tape driver is used:

;   0) Null device

;   1) WinAspi32.DLL with double buffering

;   2) Reserved

;   3) Windows NT native Miniport SCSI driver

TapeInterface=0

; Host adapter number (0-3) to use:

HostAdapterNumber=1

; 'DoubleBuffering' determines if a double buffering strategy is used by GEAR.

; Has to be set to FALSE if same SCSI card is used for the tape unit and

; system hard drive (with data files).

DoubleBuffering=TRUE

; SCSI ID of tape unit (only relevant in case of multiple units):

TargetID=4

;

;
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[harddisk]
;
; Parameters for access of raw SCSI hard disks and CD-ROM drives:
; 'DiskInterface' determines which type of disk driver is used:
;   1) WinAspi32.DLL with double buffering
;   2) Reserved
;   3) Windows NT native Miniport SCSI driver
DiskInterface=1
; Host adapter number (0-3) to use:
HostAdapterNumber=0
; 'BufferSize' determines the size of the SCSI buffer(s) allocated by GEAR.
; The setting must be between 32768 (32 KB) and 65280 (GEARalmost 64 KB).
BufferSize=65280
; 'DoubleBuffering' determines if a double buffering strategy is used by GEAR.
; Has to be set to FALSE if same SCSI card used for the raw SCSI disk and
; system hard drive (with data files).
DoubleBuffering=TRUE
; SCSI ID of disk device (only relevant in case of multiple units):
TargetID=6
;
;end of GEAR.INI

Generic Information

The first part of the gear.ini files contains the information described in the following 
sections.

Working Directory This parameter—under generic—specifies the directory in which GEAR looks for the 
volume administration files during startup. If this parameter is not specified, 
GEAR uses the directory specified as the working directory in the program 
Properties dialog in the GEAR program group.

WorkingDirectory=C:\GEARIMG95

DefaultDiscSize This parameter specifies the default disc size in the Create Project window. Default 
the size is 74 minutes.

DefaultTrackType This parameter specifies the default tracktype in the DVD/CD type settings panel. 
Default the track type is ISO.

MSBAudio This parameter—under generic—specifies whether the audio for all tracks is MSB 
(most significant byte first). The default value is False. This is an optional parameter. 
Valid values are True or False.

MSBAUDIO=False

Warning! If you don’t verify this parameter is set correctly, writing might fail. This is most 
common when a file has been changed unexpectedly. Use this option with care. 
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Customer Information The first three customer information parameters—under generic—can be the same for 
all your CD-ROM titles. 

• CustomerName=your own name

• CustomerContact=your contact person

• CustomerPhone=your telephone number

The last three fields are usually different for each CD-ROM title.

• MasterIDCode=your mastering code

• ReferenceCode=your reference code

• DiscTitle=your new CD title

This information is written to the tp_ident.txt and wo_ident.txt files when you write to 
a premaster tape or CD-R disc. Some premaster companies ask you to supply this 
information on premaster tape and/or paper.

Generation Information The following sections describe the information in the generation part of the gear.ini 
file. This information is used when you create a new volume. Afterwards, you can 
change the information for a selected volume using the Volume Descriptor command in 
the Edit menu in GEAR. All identifiers must conform to the ISO standard for 
interchange level 1. GEAR uses the default values if the parameters aren’t specified.

SystemIdf Identifies the system. The default value is GEAR.

PublisherIdf Identifies the person who specified the content of the volume set for this volume. If the 
first character is an underscore (_), the rest of the parameter specifies an identifier for a 
file that contains the publisher identification. This file has to be loaded in the root 
directory. The default value is an empty string.

If the name begins with an underscore, an extension and/or version number may be 
omitted.

DatePreparerIdf Identifies the person or other entity that controls the preparation of the data to be 
recorded on the volume. If the first character is an underscore, the rest of the field 
specifies an identifier for the file that contains the data preparer identification. This file 
has to be loaded in the root directory. The default value is ELEKTROSON or GEAR.

ApplicationIdf Identifies the specification of how the data is recorded on the volume set that this 
volume belongs to. If the first character is an underscore, the rest of the parameter 
specifies an identifier for the file that contains the application identification. This file 
has to be loaded in the root directory. The default value is an empty string.

ApplicationUse Identifies the language for an EB (XA) disc. The default value is an empty string.
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CopyRightFileIdf Specifies the identification for a file that contains the copyright statement for the 
volume set. The file is loaded in the root directory. The default value is an empty string.

AbstractFileIdf Identifies for the file that contains the abstract statement for the volume set. This file is 
loaded in the root directory. The default value is an empty string.

BibliographicFileIdf Identifies for a file that contains bibliographic records interpreted according to 
standards that are the subject of an agreement between the originator and the recipient 
of the volume. This file is loaded in the root directory. The default value is an empty 
string.

MaxDirNestingLevel Identifies the maximum nesting levels for directories on the CD. The root level is 1. ISO 
allows directory nesting up to eight levels. GEAR allows a directory nesting up to 24 
levels. The default value is 12.

MaxNrDirsInVolume Specifies the maximum number of directories in the volume in order to calculate the 
number of blocks needed for the path tables. This number may not be larger than 65535. 
The default value is 2048.

NonISOName Handling Specifies how non-ISO names for files and directories are handled. Valid values are:

ArchiveOnly When the Archives Only check box is turned on in the Volume Settings dialog (Edit 
menu), GEAR loads into the image only files with the archive bit set. Tape archiving 
software usually only archives files that have the archive bit set. This information is 
reset when the file is written to tape. GEAR offers you the same functionality for CD-
R writing. The default value is FALSE.

ArchiveReset The archive bit of a file can be reset after loading it into a project. Valid values are 
True and False. The default value is False.

When the value 
is…

This happens…

0 (default) For each non-ISO name encountered, a dialog prompts you to translate to 
an ISO-compliant name or skip the name.

1 Non-ISO names are ignored; files are loaded with their original names.

2 Lowercase characters are translated to uppercase characters. For names 
that still contain non-ISO characters, a dialog prompts you to translate to 
an ISO-compliant name or skip the name. This value is especially useful 

in a UNIX environment.

3 All non-ISO names are translated to ISO-compliant names. Non-ISO char-
acters are replaced by an underscore (_). A warning appears if duplicate 

names are generated.

4 All non-ISO names are translated to ISO level 1-compliant names.
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LoadHiddenFiles This parameter specities if hidden files should be loaded into the project. The default 
value is TRUE. 

LoadSystemFiles This parameter specifies if System files should be loaded into the project. The default 
value is TRUE

CD Recording Information

You can change the following parameters using the CD-R command in the Settings 
submenu of the Options menu. All fields must be specified. The values as specified in 
the default gear.ini file are usually used.

UsePhysicalImageFiles Specifies whether the physical image is used to write to the CD-recordable. Sometimes 
if may be necessary to use a physical image file to meet the data transfer rate 
requirements; in general, writing with the physical image is faster. Valid values are True 
and False. The default value is False.

VerifyImage Specifies whether the GEAR image should be verified before it is converted to a 
physical image, written to CD-R, or written to premaster tape. For each file in each track 
in the virtual image, a verify will check the time, date, and size at loading against the 
current time, date, and size of the file. If any file has been changed, a message is 
displayed. The default value is TRUE.

EstimateBeforeWrite Specifies whether GEAR does a performance check before it writes the data to CD-R. 
Valid values are True and False. The default value is False.

Warning! You can’t add data to a disc that is written disc at once.

WriteEnable Specifies whether the CD recorder actually writes the image file to the CD-R. Some CD 
recorders can be set to a test mode during which the data is not actually written to CD-
R disc. You can use this mode to test whether the computer system meets the data 
transfer requirements for the CD recorder for a specific CD-ROM image file. If the CD 
recorder doesn’t support this mode, the parameter is ignored. Valid values are True and 
False. The default value is FALSE.

On some recorders, such as Sony, you have to set a switch on the unit rather than setting 
this mode.

WriteMethod Specifies the write method. Possible values are:

1. Disc At Once recording]

2. Track At Once recording

3. Fixed packet writing

The default value is 2.
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NrOfWriters For the Yamaha PDS301 and Sony CDW900E only, specifies the number of writers 
used by the CD recorder while writing the image file to the CD-R. Valid values are 1 to 
14 for the Yamaha, and 1 to 32 for the Sony. The default value is 1.

Warning! If you use multiple writers for the Yamaha, the writers must have successive numbers 
(refer to your Yamaha documentation).

ReadSpeed Specifies the reading speed of the CD recorder. A value of 1 means real-time recording 
(150KB/s). If the recorder doesn’t support this parameter, it’s ignored. Valid values are 
1, 2, 4, and 6. The default value is 4.

WriteSpeed Specifies the recording speed of the CD recorder. A value of 1 means real-time 
recording (150KB/s). If the recorder doesn’t support this parameter, it’s ignored. Valid 
values are 1, 2, 4, and 6. The default value is 2.

Fixation Specifies whether the CD recorder fixates the CD-ROM after the image file has been 
written to the CD-R. If the CD recorder doesn’t support this mode, the parameter is 
ignored.

You can use this parameter to write track at once; the last track must be written with 
fixation set to True and all the previous tracks must be written with fixation set to False. 
Valid values are True and False. The default value is True.

Warning! Only a fixated image can be read on a CD-ROM player.

MultiSession Specifies whether the CD-R disc is recorded so that you can append new sessions (data) 
to the disc in the future. If a CD-R is written with this parameter set to False, you 
can never use the disc for recording new sessions. If the CD recorder doesn’t 
support this mode, the parameter is ignored. The default value is False.

VerifyAfterWrite Specifies whether GEAR verifies data after it has written the data source to CD-R. 
Valid values are True and False. The default value is TRUE.

CDRInterface Specifies the type of CD-R driver. The default value is 2.

0. Null device

1. WinAspi32.dll with double buffering

2. WinAspi32.dll with cyclic buffering

3. Windows NT native Miniport SCSI driver

HostAdapterNumber Specifies the host adapter number that’s used. If you’re using the ASPI manager as 
the device interface for multiple controllers and your CD recorder is recognized by 
ASPI but not by GEAR, you probably have to change the HostAdapterNumber. The 
default value is 1. Valid values are 0, 1, 2 and 3.
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BufferSize Specifies in bytes the buffer size allocated by GEAR for writing CD-R discs. The buffer 
size must be between 32786 (32Kb) and 65280 (almost 64Kb). A larger buffer size may 
be useful when the data transfer rate has some unexpected “dip.” If the average transfer 
rate is too low, a large buffer size doesn’t always help. The default value is 32768. 
Recommended values are:

• 32768 for cyclic buffering (CDRInterface=2)

• 65280 for CDRInterface 1 and 3.

DoubleBuffering Specifies whether GEAR should use a double buffering strategy. You can only choose 
TRUE if the CDRInterface value is set to 1. If you use the same SCSI card for both CD 
recorder and hard disk drive you must choose FALSE. The default value is TRUE.

NrOfCyclicBuffers Specifies the number of cyclic buffers allocated by GEAR. You can only use cyclic 
buffering in combination with CDRInterface=2. The default value is 96.

TargetID This ID can range from 0 to 6; a value of 7 is normally used by the Adaptec controller. 
If only one CD-R unit is connected, the software automatically finds the unit, regardless 
of its ID. If you use multiple units, the unit with the specified CDRTargetID is used. If 
no value is specified, the unit with the highest number is used. The default value is 5.

UseMediumChanger Specifies whether the GEAR software looks for a medium changer for loading and 
unloading CD-R discs. Valid values are True and False. The default value is False.

DriveNrInMedium Changer Specifies the jukebox drive that’s the CD recorder. Currently, there is no other way for 
GEAR to get this information. Valid values depend on the number of the driver in the 
jukebox. The default value is 3.

FirstSlotNumber Specifies the number of the first slot in the jukebox. The default number is 1.

NrOfSlotsInitialized Specifies the maximum number of slots to be initialized. The default value is 10.

Premaster Tape Information

You can change the following parameters using the Tape command in the Settings 
submenu of the Options menu. These parameters, which specify CD-ROM XA related 
information, are ignored in the ISO only version. You must specify a vale for each 
parameter. Usually the default values specified in the gear.ini file are used.

DDPFormatTape Specifies whether the DDP files (DDPID, DDPMS, AND PQDESCR) are written to the 
premaster tape. The DDP files are also written to hard disk. Valid values are True and 
False. The default value is True.
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FileOption

ISOTrackSectorSize Specifies the sector size to be used on tape for an ISO track. Valid values are 2048 and 
2352 (EDC/ECC is added for sector size 2352). The default value is 2048.

ISOTrackBlocking Factor Specifies the tape blocking factor for a CD-ROM track. Valid values are 4 and 6. The 
default value is 4.

ISOTrackWith 
PregapPostgap

Specifies whether the pregap and postgap are written to tape for an ISO track. Valid 
values are True and False. The default value is False.

XATrackSectorSize Specifies the sector size to use on premaster tape for a CD-ROM XA track. Valid values 
are 2336 and 2352 (EDC/ECC is added for sector size 2352). The default value is 
2336.

XATrackBlocking Factor Specifies the tape blocking factor for a CD-ROM XA track. Valid values are 4 and 
6. The default value is 4.

XATrackWith 
PregapPostgap

Specifies whether the pregap and postgap are written to premaster tape for a CD-
ROM XA track. Valid values are True and False. The default value is False.

DATrackWithPause Specifies whether the pause of CD digital audio tracks is written to premaster tape. 
Valid values are True and False. The default value is False.

Scrambling For2352Sectors Specifies whether the 2352 sectors must be scrambled before they are written to 
premaster tape. This parameter is used only if the sector size of the track written to 
tape is 2352. Valid values are True and False. The default value is False.

WriteIdentTxt OnTape Specifies whether the tp_ident.txt file is written to tape. Valid values are True and 
False. The default value is False.

When the value 
is…

This happens…

1 Each track is written to a separate tape file on a separate tape. It’s impossible to 
write DDP information to tape when using this method.

2 (default) Each track is written to a separate tape file. All files are then written to one tape.

3 Tracks of the same type are combined into one tape file. The tape files are writ-
ten to the same tape. This option is useful when there are many small audio 

tracks in the volume. Using the previous methods would result in a large number 
of filemarks on the tape that could cause problems while mastering.

4 All tracks are written to one file (contiguous image). Sector size, scrambling, 
blocking factor and gap/pause inclusion are set to mandatory values.
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UsePhysicalImage Files Specifies whether a physical image file is used for writing to premaster tape. In general, 
writing using the physical image is faster. Valid values are True and False. The default 
value is False.

VerifyAfterWrite Specifies whether GEAR verifies data after it has written the data source to premaster 
tape. Valid values are True and False. The default value is False.

TapeInterface Specifies the tape interface to be used. The default value is 0.

0. Null device

1. WinAspi32.dll with double buffering

2. Reserved

3. Windows NT native Miniport SCSI driver

HostAdapter Number Specifies the host adapter number used. If you’re using the ASPI manager as the device 
interface for multiple controllers and your tape unit is recognized by ASPI but not by 
GEAR, you probably have to change the HostAdapterNumber. Valid values are 0, 1, 2 
and 3. The default value is 1.

DoubleBuffering Specifies if double buffering is used in GEAR. If the ame SCSI card is used for the tape 
device and the hard disk with the data files you must choose FALSE. The default value 
is TRUE.

TargetID This ID can range from 0 to 6; a value of 7 is normally used by the SCSI controller. If 
only one tape unit is connected, the software automatically finds the unit, regardless of 
its ID. If you use multiple units, the unit with the specified TapeTargetID is used. If no 
value is specified for TapeTargetID, the unit with the highest number is used. The 
default value is 4.

Hard Disk Information

Disk Interface Specifies the type of disk driver used. The default value is 1

1. WinAspi32.dll with double buffering

2. Reserved

3. Windows NT native SCSI Miniport driver

HostAdapterNumber Specifies the host adapter number. Possible values are 0,1,2 and 3. the default value is 0

Buffersize Specifies the size of the SCSI buffers allocated by GEAR. The setting must be between 
32768 (32Kb)and 65280 (almost 64Kb). The default value is 65280.

Doublebuffering Specifies if GEAR uses double buffering. Set the value to FALSE if the raw SCSI disk 
and the hard disk with the data files for the project are on the same SCSI card. The 
default value is TRUE.
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TargetID Specifies the SCSI ID of the hard disk. The default value is 6.

You can change the information in the Gear Preferences file with a standard text editor 
like SimpleText, however, we recommend you use the commands available in the 
GEAR menus. For details, see Chapter 8 and Appendix B.

As you look at the Gear Preferences file, keep in mind the following points:

• Lines that start with a semicolon are treated as comments—information that 
doesn’t affect how GEAR performs.

• You must enter parameters immediately after the = sign; parameters are interpreted 
beginning with the first character that follows the = sign.

• All parameters are case sensitive.

General Preferences General preferences include the default CD type and number of copies that appear in the 
Workbench window and the maximum size CD-R size that appears in the New CD 
Image dialog.

Default CD Type The default type of CD that appears next to CD Type in the Workbench window when 
you launch GEAR.

Maximum CD-R size for 
image files

They default size that appears in the dialog when you create a new CD image.

Number of copies The default value that appears in the Workbench window next to Copies.

Mastering Information

Saved with an image and written to the tp_ident and wo_ident files when you 
premaster and write to a tape recorder.

Company Name Written to the tp_ident file when you write to premaster tape or CD-R disc.

Your Name Written to the tp_ident file when you write to premaster tape or CD-R disc.

Phone # Written to the tp_ident file when you write to premaster tape or CD-R disc.

Master ID Code Written to the tp_ident and wo_ident files when you write to premaster tape or CD-
R disc.

Reference Code Written to the tp_ident and wo_ident files when you write to premaster tape or CD-
R disc.

Disc Title Written to the tp_ident and wo_ident files when you write to premaster tape or CD-
R disc.
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Volume Attributes

Volume attributes let you specify how GEAR should handle invalid ISO names, the 
maximum number of folders you can have in an image, the maximum number of nested 
folders you can have, and whether to hide files that you’ll copy to an image.

When copying files with 
Mac names to an ISO Image

Specifies how non-ISO names for files and directories are handled. Valid values are:

Maximum number of folders 
in volume

Specifies the maximum number of directories in the volume in order to calculate the 
number of blocks needed for the path tables. This number may not be larger than 65535. 
The default value is 500.

Maximum depth of folder 
nesting

Identifies the maximum nesting levels for folders on the CD. The root level is 1. ISO 
allows folder nesting up to eight levels. GEAR allows a folder nesting up to 12 levels. 
The default value is 8.

Hide files that will be copied 
to the Image

Indicates whether files you create are to be hidden in the Session window.

Volume Descriptor Information

These settings include identification information that’s saved in the administration files 
for each image you create.

System ID Identifies the system. The default value is an empty string.

When the value 
is…

This happens…

0 (default) For each non-ISO name encountered, a dialog prompts you to translate to 
an ISO-compliant name or skip the name.

1 Non-ISO names are ignored; files are loaded with their original names.

2 Lowercase characters are translated to uppercase characters. For names 
that still contain non-ISO characters, a dialog prompts you to translate to 
an ISO-compliant name or skip the name. This value is especially useful 

in a UNIX environment.

3 All non-ISO names are translated to ISO-compliant names. Non-ISO char-
acters are replaced by an underscore (_). A warning appears if duplicate 

names are generated.

4 All non-ISO names are translated to ISO level 1-compliant names.

5 All non-ISO names are translated to ISO level 1-compliant names. The 
Rock Ridge-specific information is specified in the proposed IEEE stan-

dards P1281 and P1282; it is specifically meant for UNIX systems. A 
value of 5 should be used on UNIX systems only.
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Publisher ID Identifies the person who specified the content of the volume set for this volume. If the 
first character is an underscore (_), the rest of the parameter specifies an identifier for a 
file that contains the publisher identification. This file has to be loaded in the root folder. 
The default value is an empty string.

If the name begins with an underscore, an extension and/or version number may be 
omitted.

Data Preparer ID Identifies the person or other entity that controls the preparation of the data to be 
recorded on the volume. If the first character is an underscore, the rest of the field 
specifies an identifier for the file that contains the data preparer identification. This file 
has to be loaded in the root folder. The default value is an empty string.

Application ID Identifies the specification of how the data is recorded on the volume set that this 
volume belongs to. If the first character is an underscore, the rest of the parameter 
specifies an identifier for the file that contains the application identification. This file 
has to be loaded in the root folder. The default value is an empty string.

Application use Identifies the language for an EB (XA) disc. The default value is an empty string.

Copyright file ID Specifies the identification for a file that contains the copyright statement for the 
volume set. The file is loaded in the root folder. The default value is an empty string.

Abstract file ID Identifies for the file that contains the abstract statement for the volume set. This file is 
loaded in the root folder. The default value is an empty string.

Bibliography file ID Identifies for a file that contains bibliographic records interpreted according to 
standards that are the subject of an agreement between the originator and the 
recipient of the volume. This file is loaded in the root folder. The default value is 
an empty string.
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File and Directory/Folder Naming

ISO 9660 File Names
Each file name consists of three components:

• Name

• Extension

• Version Number

These components are formatted as follows:

<name>.<extension>;<version>

Keep in mind the following points:

• A name or extension can consist of zero or more alphanumeric characters 
and underscores ( _ ). 

• The version number can range from 1 to 32767. 

• The name and extension together must consist of at least one character, for 
example .000;1 is a valid ISO-9660 file name.

Levels of Interchange

ISO-9660 defines three levels of interchange:

• Level 1 restricts the number of characters in the name to eight and the num-
ber of the characters in the extension to three.

• Levels 2 and 3 restrict the total length of the name and extension to 30 char-
acters, excluding the dot and semicolon. Within GEAR, the file name 
length is restricted to 30.
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Order of Files in a Directory/Folder

Files are sorted in alphabetical order. If two file names don’t have the same number of 
characters, the shorter name is treated as if it’s extended with extra spaces. This rule 
applies to both the name and the extension.

If two files have identical names, the file with the higher version number is sorted first, 
for example, AA.;2 is sorted before AA.;1.

ISO 9660 Directory/Folder Names

Keep in mind the following points:

• A directory name consists of up to 31 uppercase, alphanumeric characters and 
underscores ( _ ).

• With the root level being level one, the maximum nesting level of directories is 
eight.

• The total number of characters that specify a file within a directory or path must be 
fewer than 256.

• Directory names are sorted alphabetically.

Sorting Order

The sorting order of characters is defined by ISO-646.

• 0 through 9 are sorted first

• A through Z are sorted next

• Underscores are sorted last

Non-ISO Filename Handling

Due to the ISO 9660 file name conventions (that are supported by almost every 
operating system capable of reading CD-ROM units) GEAR needs to convert certain 
filenames. The option ANon-ISO filename handling@  determines how GEAR 
converts the filenames that are placed in the GEAR image (and therefore on the 
resulting CD-R). 
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Below you will find an overview of the available values for this option:

• Prompt user
If the filename is too long or contains non-ISO characters, you will be prompted to 
enter a new filename.

• Do not change
This option copies the files with exactly the same filename, without checking ISO 
compatibility.

• Translate to uppercase only
The original filename is retained, but all characters are converted to upper-case.
Use this setting for CDs written under Windows 95 that must be read in MS_DOS 
or MS-Windows 3.1x. Long Windows 95 filenames in uppercase are allowed.
Also use this setting for Windows NT 3.51, which does not allow lowercase 
filenames to be read from CD.

• Translate to ISO completely
All characters are translated to upper-case and the filename is shortened to fit the 
8.3 (FILENAME.EXT) format, also known as ISO level 1.
This setting should be used for MS-DOS and MS-Windows 3.1x, because in these 
environments only fully ISO-compliant filenames can be used (see also above 
“Translate to uppercase only”).

• Translate to ISO level 2
All characters are translated to upper-case and filename is shortened to a 
maximum of 31 characters. Only set table in the GEAR initialization or 
preferences file.

Note: Filenames containing characters such as Ö, Ä or Ç cannot be used. Such files 
cannot be written to CD. 
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Troubleshooting 

In this appendix you will find a checklist for common problems. In addition we 
advise you to visit our Website at www.gearsoftware.com for:

• updated recorder lists and drivers

• answers to frequently asked questions not included here

• GEAR Software product information

Recording problems

Below you will find some general remarks on CD recorders, SCSI interfaces and 
buffers to help you solve problems related to the recording of your discs. More 
details are available at the GEAR Software Website www.gearsoftware.com .

SCSI CD recorders 

When installing your recorder and GEAR, please adhere to the following: 

• Make sure the Termination Power (Term.Pwer) jumper is removed from 
your recorder. 

• In Windows 95 Do NOT load SCSI and / or CDROM drivers in your CON-
FIG.SYS and AUTOEXEC.BAT. These are 16-bit drivers and can conflict 
with GEAR. 

• Type Switchable recorders (Like Ricoh, Sony, etc.) can best be set as Type-
5 recorders; 

• Use the GEAR Software CD-Recorder driver (gearcdr.vxd). You can find 
this driver on the GEAR CD. If you have an older version of GEAR, please 
contact your local distributor or download it from www.gearsoftware.com. 
This driver enables the use of the Miniport by GEAR and can be used in 
conjunction with other drivers (i.e. EZ-SCSI).
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SCSI interfaces 

If your SCSI-interface does not function properly, you can try the following:

• Install the Microsoft Windows 95 Service Pack(s). Do this before installing the 
SCSI-Card specific drivers. Preferred are Busmaster PCI SCSI Cards. These cards 
execute all SCSI commands themselves and therefore relieve the CPU workload. 
This way more CPU time is available for the CD-Recording program and “Buffer 
underrun”, “Buffer overrun” and “Buffer empty” errors are reduced or solved; 

• When using a CD-Recorder in combination with a SCSI-Harddisk, it is recom-
mended that the CD-recorder & the SCSI-Harddisk are on separate controllers; 

• Check the Termination Power of the recorder or any other SCSI device. This must 
be deactivated! 

• If a scanner is attached, deactivate the scanner & restart Windows before recording. 

• Use the GEAR Software CD-Recorder driver. You can find this driver on the 
GEAR CD. If you have an older version of GEAR, then please contact your local 
distributor or download it from “www.gearsoftware.com”. This driver enables the 
use of the Miniport by GEAR and can be used in conjunction with other drivers (i.e. 
EZ-SCSI).

Buffer settings 

If you are faced with a buffer underrun, an empty buffer or a buffer overrun, this 
probably means that there is a problem with the data transfer rate. This could have any 
number of causes: the system board, the hard-disk, the SCSI-card, Windows, a 
conflicting driver or any active application or task. Below you will find a list of tips 
which might solve the problem. 

• You must first check if your system recognizes and controls all devices correctly. 
Every device must be checked: modem, mouse, SCSI-Controller, etc. Every device 
influences your system in one way or the other, even those which seem not to have 
any affect on CD-Recording. 
You can check this by opening Control Panel > System Properties > Device man-
ager. If there is an exclamation mark (!) something is wrong and you should solve 
this problem. 

• Before writing, close all background tasks, schedulers & screen savers. 

• If you dragged & dropped files from a CD-ROM player in your recorder-drive, the 
player might be too slow. This is not determined by speed of the drive, but by its 
access time. Even if you have a 20x CD-ROM player, if the access time is too slow, 
writing will not be successful. Therefore do not use drag & drop to copy from CD-
ROM, but use Copy Track from the Disc info menu or generate a Physical image. 
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• Some hard disks have to re-calibrate periodically. During the re-calibration phase, 
the drive is inactive. This means the data-flow stops and the buffer cannot be filled 
or emptied resulting in an error. Use a hard disk that does not re-calibrate to store 
your GEAR image on. 

• Try defragmenting the hard disk, preferably full-defragmentation. 

• Try using a Physical Image. Select Convert to Physical and make sure Use Physical 
image is selected in the recorder settings. 

• In Windows 95 add the following to the system.ini:
[VCACHE]]
MinFileCache=256
MaxFileCache=2048

• Update your Windows 95 to the latest version with the Microsoft Windows 95 Ser-
vice Pack(s). You find your current version number in the System properties dia-
log. 

• Set the read-ahead optimization to None. In the System Properties you can find the 
Performance tab. Click on the File System button to display the File System Prop-
erties. Here you can adjust the Read-ahead-Cache.

• Select another drive for your Windows swap file. If the swap file and the files you 
want to write to CD are on the same drive, you lose performance. In the System 
Properties you can find the Performance tab. Click on the Virtual Memory button 
to display the Virtual Memory settings. Here you can specify your own settings.
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Reference List

Useful references

1. ANSI X3.27-1987, File Structure and Labeling of Magnetic Tapes.

2. International Standard ISO-9660, First Edition 1988-04-15, Information 
Processing, Volume and File Structure of CD-ROM for Information 
Interchange.

3. System Description on CD-ROM XA, May 1991, Philips/Sony

4. Compact Disc Interactive, Full Functional Specification (Green Book), 
September, 1990, Philips/Sony.

5. International standard ISO/IEC 13346, First Edition 1995-12-15, 
Information Technology-Volume and file structure of write-once and 
rewritable media using non-sequential recording for information 
interchange, Part 1-5

6. Universal Disk Format Specification, Revision 1.50, 1997, Copyright 
Optical Storage Technology Association.
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